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  Plug the power cord into the wall socket directly. Do not use a extension cord.

  If the power cable or plug is worn out or damaged, pull the power plug out. 

  Do not remove the cover or bolt except specified on this USER MANUAL to prevent

 from being exposed to electric shock or laser radiation (if a laser application is used).

  Under the following conditions, turn the power switch to ON position and then pull the

 power plug out:      

 - Something is spilled on the Machine; 

   - Service or repair request for the Machine is under consideration; or

   - The cover for the Machine is damaged.

  For the Machine with toner, do not burn the spilled toner or waste toner.  

 If toner particles are exposed to flames, it may ignite.  

  For discarding the Machine, use our designated shops or proper pickup places. 

  If not used in long time or when the business is closed at quitting time, turn the power

 switch to OFF position. Otherwise, it may be a cause of flash fire.

  Protect the Machine against moist or wet place with rain or snow. 

  Before moving the Machine, pull the power cord out of the wall socket. 

 Pay attention to the power cord not to be damaged while moving the Machine.

  When pull the power cord out of the wall, do not pull the cable but give a pull to the plug.

  Do not drop clip, staple, or small-sized metal object into the Machine inside.

  When controlling the Machine Inside for the purpose of removing paper jam or cleaning

 the Machine inside cleaning, pay attention to negligent accident.

  For the Machine with toner, keep the toner and toner bottle out of the reach of children.

  Do not discard the Machine or the consumables in the household waste disposal site. 

 In discarding the Machine, make use of our designated shops or proper pickup places.

  The Machine inside may be very hot. Never touch the component with “CAUTION: High 

 Temperature” or around. If not, it may cause a burn.  

 Our Product conforms to the standard of high quality and performance.

  We recommend you to use honest components available for buying from our designated

 shops. 

Users MUsT keep The followings when Using The Machine: 

guidelines for safe Use 

warning : negligence of the instructions may cause death or serious injury:

caUTion : negligence of the instructions may cause slight injury or loss of  

       property. 



                  

Thank you very much for your buying the SINDOH’s Product.   

This USER MANUAL specifies the right way to use the Machine and simple repairing in 

detail to maintain it in optimal state at all times and to contribute to your company’s office

rationalization and efficiency.

Please read the USER MANUAL carefully and keep it close at head, before using this 

product. Before using the Machine, read the Guidelines for Safety Use to use the Machine

sefely and correctly.

Before Using the product

prohibition and restriction of reproduction

1. The content of this USER MANUAL is subject to change without prior notice. 

 We disclaim all responsibility for any direct/indirect loss due to your handling this 

 machine or the operation results or for any damage caused by misuse. 

2. Copying or printing paper money in circulation, banknote, revenue stamp, bond, stock,

 bank bill, check, passport, or driver’s license is forbidden by the laws.

3. The works such as copyright book, music, picture, map, drawing, or photograph can be 

 used by copying it for personal or family use or within the corresponding scope, but 

 other uses are forbidden by the laws. 

4. The above contents in this paragraph are part of legislation and they are not the 

 reprinting from the legislation. We disclaim all the responsibility for the accuracy or  

 integrity. For the legality of a copy or print, we suggest you get legal advice.
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1. Overview of printer functions

The printer driver is software that specifies how to use the printing functions of this machine 

from other application software. When you install the printer driver on your computer, you can 

use a variety of this machine’s printing functions. Furthermore, the printer driver supports a 

wide range of connection methods and provides flexibility in various environments.

It also supports direct printing, a printing method that does not use the printer driver, and 

printing from a USB memory device.
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Printer Functions

12. System requirements

For Windows

Item Specifications

Operating system The supported versions of the operating system vary depending on the 

installed printer driver. For details, refer to p 2-6.

CPU Any processor of the same or higher specifications as recommended 

for your operating system

Memory Memory capacity as recommended for your operating system

The memory space must be enough for the OS and applications used.

Drive CD-ROM drive

For Mac OS

Item Specifications

Operating system Mac OS X (10.3.x, 10.4.x, 10.5.x, 10.6.x, 10.7.x, 10.8.x, 10.9.x)

CPU PowerPC, Intel Processor

Memory Memory capacity as recommended for your operating system

Drive CD-ROM drive

 Reference

  -  For details on how to use the Linux printer driver, refer to Chapter 5 “Printing in the Linux 

Environment” in [User’s Guide Applied Functions].
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3. Cable connection ports of this machine

The printer cables are connected to each port on this machine.

2 1

No. Port Description

1 Ethernet port 

(1000Base-T/

100Base- TX/10Base-T)

Use the LAN cable to connect this machine to the network. 

This machine supports the 1000Base-T, 100Base-TX and 

10Base-T protocols.

The TCP/IP (LPD/LPR and IPP) protocols and Web services 

are supported.

2 USB port Use a USB interface cable for USB connection.

Use a type A (4-pin, male) to type B (4-pin, male) USB 

cable. A USB cable measuring three meters or less is 

recommended.
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1. Preparation for printing (network connection)

Overview

Before using this machine as a printer, you need to install the printer driver on your computer.

This section describes preparatory steps for printing from this machine using the installer that are 

supplied with this machine.

Before installing the printer driver (for administrators)

1 Connecting this machine to the network

Checking a LAN cable for connection

Checking the network settings

   Check that an IP address is assigned to this machine.

2 Configuring the network printing environment

When using the Normal Printing (at Port 9100)

  Make sure that the RAW port number has been set. (Usually, you can use the default  

settings.) Use Normal Printing (Port 9100) unless otherwise specified.

When using the Internet Print (IPP)

 Check the IPP operating environment. (Usually, you can use the default settings.)

3 Preparation finished

Checking a LAN cable for connection

Check that a LAN cable is connected to the LAN port of this machine. For details on the cable con-

nection port, refer to P. 1-4.

Checking the network settings

Print out the Configuration Page, then check that an IP address is assigned to this machine.

To print out the Configuration Page, select [REPORT/STATUS] - [REPORT] - [Configuration Page].

 Reference

  -  If no IP address is displayed, you need to set up the network. For details, refer to [Quick 

Start Guide].
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Configuring the network printing environment

Set up the operating environment to suit the printing method.

If the printing method is not specified before installation, Normal Printing (Port 9100) is selected 

for printing. Use Normal Printing (Port 9100) unless otherwise specified.

For details on how to configure settings, refer to Chapter 1 "Using Web Connection" in [User's 

Guide Applied Functions].

Printing method Description

Normal Printing 

(Port 9100)

Make sure that the RAW port number has been set. (Usually, you 

can use the default settings.)

Internet Print (IPP) Check the IPP operating environment. (Usually, you can use the 

default settings.)

Secure Print (IPPS) Set up the IPPS operating environment. Establish the communication 

with SSL encryption between this machine and the computer.

 Note

  -  You cannot set up the Secure Printing (IPPS) using the installer. For details on how to set 

up the Secure Printing (IPPS), refer to Chapter 3 "Manually Installing the Printer Driver (for 

Windows)" in [User's Guide Applied Functions].

  -  If you are using Windows Server 2003 in an IPv6 environment, you cannot set up the printer 

driver using the installer.

  -  Internet Printing (IPP) is not supported in the IPv6 environment.

Allowing device information to be acquired from the printer driver

Disable the OpenAPI authentication function. (Usually, you can use the default settings.)

When you allow acquisition of device information from the printer driver, the printer driver automatically 

obtains information such as what options are installed on this machine and whether or not authentication 

settings have been configured.

For details on how to configure settings, refer to Chapter 1 "Using Web Connection" in [User's 

Guide Applied Functions].
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Easy installation of the printer driver

1 Preparing the printer driver

Preparing the printer driver CD

 For the CD, contact the administrator of this machine.

Checking the printer driver type

  Three printer drivers for different purposes are available. Select the printer driver that meets 

your printing objectives.

Checking the operating systems supported by the printer driver

 Check that your computer meets the operating environment requirements of the printer driver.

2 Installing the printer driver to the computer

Installing the printer driver using the installer

  Insert the printer driver CD into the drive, and install the software by following the on-screen 

instructions.

Performing a test print

 If necessary, make a test print, then check that it is acceptable.

3 Preparation finished

Preparing CDs for the printer driver

The following CD-ROMs are supplied with this machine. The printer drivers are included on the 

Driver CD.

CD-ROM Description

Driver CD Contains Windows printer driver (PCL/PS/XPS), Mac OS printer 

driver, Linux printer driver, and TWAIN driver. This also contains 

the page for downloading utility software.

User Manual CD Contains user's guides.



2-5

Printing in the Windows Environment

2

Checking the printer driver type

The following types of printer drivers are available. Select the printer driver that meets your printing 

aims.

Printer driver
Page description 

language
Description

PCL driver PCL6 This is a standard driver for printing 

general office originals.

Among the three drivers, this driver 

provides the fastest printing speed.

PS driver PostScript 3 Emulation This driver is effective for high-

definition printing of data created in 

PostScript-supporting  application 

software from Adobe or other vendors.

This driver is often used in graphics and 

light printing applications where good 

color reproducibility is important.

XPS driver XPS Developed after Windows Vista, this 

driver supports XML Paper Specification 

(XPS).

This driver has several advantages, 

including highquality reproduction of 

translucence.
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Checking the operating systems supported by the printer driver

The following lists the printer drivers included on the CD-ROM supplied with this machine and the 

supported operating systems.

Printer driver Supported operating systems

PCL driver

PS driver

Windows Server 2003, Standard Edition (Service Pack 2 or later) 

Windows Server 2003, Enterprise Edition (Service Pack 2 or later) 

Windows Server 2003 R2 Standard Edition

Windows Server 2003 R2 Enterprise Edition

Windows Server 2003, Standard e64 Edition

Windows Server 2003, Enterprise e64 Edition

Windows Server 2003 R2, Standard e64 Edition

Windows Server 2003 R2, Enterprise e64 Edition

Windows Vista Business (Service Pack 2 or later)* 

Windows Vista Enterprise (Service Pack 2 or later)* 

Windows Vista Home Basic (Service Pack 2 or later)* 

Windows Vista Home Premium (Service Pack 2 or later)*

Windows Vista Ultimate (Service Pack 2 or later)*

Windows Server 2008 Standard (Service Pack 2 or later)*

Windows Server 2008 Enterprise (Service Pack 2 or later)*

Windows Server 2008 R2 Standard 

Windows Server 2008 R2 Enterprise 

Windows 7 Home Basic

Windows 7 Home Premium *

Windows 7 Professional * 

Windows 7 Enterprise * 

Windows 7 Ultimate * 

Windows 8 */Windows 8.1 *

Windows 8 Pro*/Windows 8.1 Pro*

Windows 8 Enterprise*/Windows 8.1 Enterprise*

Windows Server 2012 Datacenter

Windows Server 2012 Standard

Windows Server 2012 R2 Datacenter

Windows Server 2012 R2 Standard
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Printer driver Supported operating systems

XPS driver Windows Vista Business (Service Pack 2 or later)* 

Windows Vista Enterprise (Service Pack 2 or later)* 

Windows Vista Home Basic (Service Pack 2 or later)* 

Windows Vista Home Premium (Service Pack 2 or later)* 

Windows Vista Ultimate (Service Pack 2 or later)* 

Windows Server 2008 Standard (Service Pack 2 or later)*

Windows Server 2008 Enterprise (Service Pack 2 or later)*

Windows Server 2008 R2 Standard 

Windows Server 2008 R2 Enterprise 

Windows 7 Home Basic

Windows 7 Home Premium *

Windows 7 Professional * 

Windows 7 Enterprise * 

Windows 7 Ultimate * 

Windows 8 */Windows 8.1 *

Windows 8 Pro*/Windows 8.1 Pro*

Windows 8 Enterprise*/Windows 8.1 Enterprise*

Windows Server 2012 Datacenter

Windows Server 2012 Standard

Windows Server 2012 R2 Datacenter

Windows Server 2012 R2 Standard

 * Supports 32-bit (e86)/64-bit (e64) environment.
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Installation procedure

Install the printer driver using the installer.

  Administrator privileges are required to perform this task.

  Use the Driver CD.

1 Insert the printer driver CD into the CD-ROM drive of the computer.

 Make sure that the installer starts, then proceed to Step 2.

  If the installer does not start, open the printer driver folder on the CD-ROM, double-click 

[Setup.exe], then go to Step 3.

 If the [User Account Control] window appears, click [Continue] or [Yes].

2 Click [Printer].

3 Read the license agreement, then click [AGREE].

4 Check the contents of the [Readme] window, then click [Next].

5 Select [Install printers/MFPs], then click [Next].

 Connected printers are detected.

  For Windows Vista/7/8/8.1/Server 2008/Server 2008 R2/Server 2012/Server 2012 R2, you can 

select [Preference for IPv4] or [Preference for IPv6]. The address has the preference when 

detected in both IPv4 and IPv6.

6 Select this machine, then click [Next].

 If this machine is not detected, restart it.

  You do not need to change the printing method from [Normal Printing] (Port 9100) unless 

otherwise specified by the administrator.

 As the printing method, you can select [Normal Printing] or [Internet Printing] (IPP).

  Among the connected printers, only the target model is automatically detected and  

displayed. If multiple target models are displayed, check the IP addresses.

  If the connection to this machine cannot be recognized, it is not displayed in the list. In such 

a case, select [Specify the Printer/MFP Except for the Above. (IP Address, Host Name)], then 

manually specify the IP address and host name of this machine.
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7 Select the check box of the printer driver you want to install, then click [Next].

 For features of each printer driver, refer to P. 2-5.

8 Check the components to be installed, then click [Install].

9  If necessary, change the printer name or print a test page, then click [Finish].

 Installation of the printer driver is then completed.

Settings Description

[Review] Displays the installed components for checking.

[Rename Printer] Changes this machine name, if necessary.

[Property] Sets the optional operating environment of this machine.  

For details, refer to P. 2-11.
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Settings Description

[Print Setting] Changes the default print settings of this machine, if necessary. 

For details, refer to P. 2-11.

[Print Test page] If necessary, print a test page to check that printing process 

works correctly.

 Reference

  -  When you finish installing the printer driver, configure the default settings of the printer 

driver. For details, refer to P. 2-11.
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Initializing the printer driver

Configuring the optional environment of this machine

When you use this machine for the first time, check that information such as what options are  

installed on this machine and whether or not authentication settings have been configured is  

correctly reflected to the printer driver.

1 Display the [Properties] window of the printer driver.

 For information on how to display the [Properties] window, refer to P. 2-62.

2  In the [Configure] tab, check the information such as what options are installed on this  

machine and whether or not authentication settings have been configured.

  By default, [Auto] in [Obtain Settings] is enabled. The information on this machine is  

automatically obtained and reflected to [Device Option].

  When [Auto] in [Obtain Settings] is disabled, clicking [Obtain Device Information], obtains 

and reflects the information on this machine to [Device Option].

  If you cannot establish communication with this machine, manually set this information in 

[Device Option]. Select the item to change from the list, and set a value in [Setting].

3 Click [OK].
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Change the default print settings

If necessary, you can change the default print settings of the printer driver.

1 Display the [Printing Preferences] window of the printer driver.

 For information on how to display the [Printing Preferences] window, refer to P. 2-68.

2  Change the print settings, and click [OK]. 

The changed settings are applied when printing is performed from any application software.

 Reference

  -  The printer driver contains a function to save favorite settings. This is useful to register 

frequently used print settings as favorite settings. For details, refer to P. 2-23.
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2. Preparation for printing (USB connection)

Overview

Before using this machine as a printer, you need to install the printer driver on your computer.

This section describes preparatory steps for printing from this machine using the installer that  

are supplied with this machine.

Easy installation of the printer driver

1 Preparing the printer driver

Preparing the printer driver CD

 For the CD, contact the administrator of this machine.

Checking the printer driver type

  Two printer drivers for different purposes are available. Select the printer driver that meets 

your printing objectives.

Checking the operating systems supported by the printer driver

 Check that your computer meets the operating environment requirements of the printer driver.

2 Installing the printer driver to the computer

Configuring the installation settings on the computer

  If you are using Windows 7/8/8.1/Server 2008 R2/Server 2012/Server 2012 R2, you need to 

change the computer settings in advance.

Installing the printer driver using the installer

  Connect the USB printer cable, insert the print driver CD into the drive, and install the  

software by following the on-screen instructions.

Performing a test print

 If necessary, make a test print, then check that it is acceptable.

3 Preparation finished
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Preparing the printer driver CD

The following CDs are supplied with this machine. The printer drivers are included on the Driver CD.

CD-ROM Description

Driver CD Contains Windows printer driver (PCL/PS/XPS), Mac OS printer 

driver, Linux printer driver, and TWAIN driver. This also contains 

the page for downloading utility software.

User Manual CD Contains user's guides.

Checking the printer driver type

The following types of printer drivers are available. Select the printer driver that meets your printing 

aims.

Printer driver
Page description 

language
Description

PCL driver PCL6 This is a standard driver for printing 

general office originals.

Of the two drivers, this driver provides 

the printing speed faster than that of 

the PS driver.

PS driver PostScript 3 Emulation This driver is effective for high-

definition printing of data created in 

PostScript-supporting  application 

software from Adobe or other vendors.

This driver is often used in graphics and 

light printing applications where good 

color reproducibility is important.
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Checking the operating systems supported by the printer driver

The following lists the printer drivers included on the CD-ROM supplied with this machine and the 

supported operating systems.

Printer driver Supported operating systems

PCL driver

PS driver

Windows Server 2003, Standard Edition (Service Pack 2 or later) 

Windows Server 2003, Enterprise Edition (Service Pack 2 or later) 

Windows Server 2003 R2 Standard Edition

Windows Server 2003 R2 Enterprise Edition 

Windows Server 2003, Standard e64 Edition 

Windows Server 2003, Enterprise e64 Edition 

Windows Server 2003 R2, Standard e64 Edition 

Windows Server 2003 R2, Enterprise e64 Edition

Windows Vista Business (Service Pack 2 or later)* 

Windows Vista Enterprise (Service Pack 2 or later)* 

Windows Vista Home Basic (Service Pack 2 or later)*

Windows Vista Home Premium (Service Pack 2 or later)*

Windows Vista Ultimate (Service Pack 2 or later)* 

Windows Server 2008 Standard (Service Pack 2 or later)* 

Windows Server 2008 Enterprise (Service Pack 2 or later)*

Windows Server 2008 R2 Standard 

Windows Server 2008 R2 Enterprise 

Windows 7 Home Basic

Windows 7 Home Premium *

Windows 7 Professional * 

Windows 7 Enterprise * 

Windows 7 Ultimate * 

Windows 8 */Windows 8.1 *

Windows 8 Pro*/Windows 8.1 Pro*

Windows 8 Enterprise*/Windows 8.1 Enterprise*

Windows Server 2012 Datacenter

Windows Server 2012 Standard 

Windows Server 2012 R2 Datacenter 

Windows Server 2012 R2 Standard

 * Supports 32-bit (e86)/64-bit (e64) environment
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Changing the installation settings (Windows 7/8/8.1/Server 2008 R2/Server

2012/Server 2012 R2)

If you are using Windows 7/8/8.1/Server 2008 R2/Server 2012/Server 2012 R2, change the computer 

settings before installing the printer driver.

1 Open the [Control Panel] window.

 In Windows 8.1, click [ ] in the Start window, then click [Control Panel].

 In Windows 8, right-click the Start window, then click [All apps] - [Control Panel].

 In Windows Server 2012/Server 2012 R2, click [Control Panel] in the Start window.

 In Windows 7/Server 2008 R2, open the Start menu, then click [Control Panel].

2 Click [System and Security] - [System].

3  Click [Advanced system settings] on the menu in the left-hand pane.

 The [System Properties] window appears.

4 In the [Hardware] tab, click [Device Installation Settings].
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5  Select [No, let me choose what to do], select [Never install driver software from Windows  

Update.], then click [Save Changes].

  After you have installed the printer driver, change the setting back to [Yes, do this  

automatically (recommended)].

6 Click [OK] to close the [System Properties] window.
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Installation procedure

Install the printer driver using the installer.

  Administrator privileges are required to perform this task.

  Use the Driver CD.

1 Connect a USB cable to the USB port of this machine.

 For details on the cable connection port, refer to P. 1-4.

 If a wizard window for adding new hardware opens, click [Cancel].

2 Insert the printer driver CD into the CD-ROM drive of the computer.

 Make sure that the installer starts, then go to Step 3.

  If the installer does not start, open the printer driver folder on the CD-ROM, double-click 

[Setup.exe], then go to Step 4.

 If the [User Account Control] window appears, click [Continue] or [Yes].

3 Click [Printer].

4 Read the license agreement, then click [AGREE].

5 Check the contents of the [Readme] window, then click [Next].

6 Select [Install printers/MFPs], then click [Next].

 USB-connected printers are detected.

7 Select this machine, then click [Next].
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8 Select the check box of the printer driver you want to install, then click [Next].

 For features of each printer driver, refer to P. 2-5.

9 Check the components to be installed, then click [Install].

10  If necessary, change the printer name or print a test page, then click [Finish].

 Installation of the printer driver is then completed.

Settings Description

[Review] Displays the installed components for checking.

[Rename Printer] Changes this machine name, if necessary.

[Property] Sets the optional operating environment of this machine. For 

details, refer to P. 2-11.

[Print Setting] Changes the default print settings of this machine, if necessary. 

For details, refer to P. 2-11.

[Print Test page] If necessary, print a test page to check that printing process 

works correctly.

 Reference

  -  When you finish installing the printer driver, configure the default settings of the printer 

driver. For details, refer to P. 2-23.
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Initializing the printer driver

Configuring the optional environment of this machine

When you use this machine for the first time, configure the printer driver so that it contains information 

such as what options are installed on this machine and whether or not authentication settings have 

been configured.

1 Display the [Properties] window of the printer driver.

 For information on how to display the [Properties] window, refer to P. 2-62.

2  In the [Configure] tab, configure the information such as what options are installed on this  

machine and whether or not authentication settings have been configured.

  If you are using Windows Vista/7/8/8.1/Server 2008/Server 2008 R2/Server 2012/Server 2012 

R2, [Auto] under [Obtain Settings] is enabled by default. Thus, the information of this machine 

is automatically obtained and applied for [Device Option].

  When [Auto] in [Obtain Settings] is disabled, clicking [Obtain Device Information], obtains 

and reflects the information on this machine to [Device Option].

  If you are using Windows Server 2003, set the option manually using [Device Option]. Select 

the item to change from the list, and set a value in [Setting].

3 Click [OK].
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Change the default print settings

If necessary, you can change the default print settings of the printer driver.

1 Display the [Printing Preferences] window of the printer driver.

 For information on how to display the [Printing Preferences] window, refer to P. 2-68.

2  Change the print settings, and click [OK]. 

The changed settings are applied when printing is performed from any application software.

 Reference

  -  The printer driver contains a function to save favorite settings. For details, refer to P. 2-23.
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3. How to print

Printing operation flow

1 Open data of the original using the application software. From the [File] menu, select [Print].

2 In [Printer Name] (or [Select Printer]), make sure that the desired printer has been selected.

 The [Print] dialog box varies depending on the application software.

3 Specify the print range and the number of copies to print.

4 Click [Properties] (or [Preferences]) to change the print settings of the printer driver, if necessary.

  The print settings you have changed here return to the default values when you exit the  

application software. For information on how to change the default values of print settings, 

refer to P. 2-11.

  The printer driver contains a function to easily recall frequently used print settings.  

For details, refer to P. 2-23.

5  Click [Print]. 

Printing is executed.
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Easily recalling frequently used print settings

Registering the frequently used setting

You can register the current print settings as a favorite and recall it when executing printing.

When you register a frequently used combination of print settings as a favorite, you can easily 

apply all of those settings just by selecting the combination from the Favorite Setting list, even  

if the combination is complicated as it contains settings on multiple tabs.

The following explains the procedure of favorite print setting.

1 In the [Printing Preferences] window, set the print conditions you want to register as a favorite.

2 Click [Add].

  When you edit an existing setting, select its name from the [Favorite Setting], then click 

[Edit]. In the Edit dialog box, you can select functions to be recalled with a favorite  

setting or import and export a favorite setting.

3 Enter names of the favorites to be registered.

  Set an icon, a comment and call options for the favorite settings, if necessary.
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Settings Description

[Name] Enter names of the favorites to be registered.

Use names that can easily be identified.

[Icon] Assign an icon to the favorite settings, if necessary.

[Sharing] Select this check box to share the favorite settings with other 

users.

[Comment] Enter a comment to the favorite setting, if necessary.

The comment is displayed when you place the mouse cursor over 

the favorite in the Favorite Setting list.

[Restore Items] Items that are determined when you start printing, such as the 

original size and the number of copies, are registered in the 

favorite. By default, these items are not recalled with the favorite. 

As necessary, you can specify them as items to be recalled.

Select the check box of items to be retrieved.

4  Click [OK].

  The print settings are registered as a favorite. When starting printing, you can select the registered 

setting from [Favorite Setting].

Customizing the setting window

You can gather setting items from difference tabs and place them in [My Tab].

Registering frequently used setting items in [My Tab] allows you to change settings in one tab, 

without switching among multiple tabs.

This section describes how to edit [My Tab].

1 Click [My Tab] - [Edit My Tab].

  You can also register a function in [My Tab] by selecting [to the LEFT] or [to the RIGHT] from 

the [My Tab] menu that is displayed by right-clicking the function.
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2  From [Setting Item List], select the function you want to register in [My Tab], then click [to the 

LEFT] or [to the RIGHT].

  Clicking [to the LEFT] places the selected function in the area to the left of [My Tab] and 

clicking [to the RIGHT] places it in the area to the right of [My Tab].

 An icon appears to the left of each function that is registered in [My Tab].

3 If necessary, move or delete the registered functions.

 To move a function, select the function and click [Up], [Down], or [Left/Right].

 To delete a function from [My Tab], select the function and click [Remove].

4  Click [OK].

 Editing [My Tab] is then completed.
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4. Useful printing functions

Changing the paper size or type

Enlarging or reducing to the paper size ([Paper Size])

To make prints, enlarge or reduce the original with the zoom ratio that is automatically determined 

from the original size and paper size.

If you select a paper size larger than the original size, the original is enlarged to the paper size.  

If you select a paper size smaller than the original size, the original is reduced to the paper size.

In [Paper Size] of the [Basic] tab, select the size of paper for printing. The zoom ratio is automatically 

determined by the paper sizes selected in [Original Size] and [Paper Size].

 Note

  - This function is enabled when [Zoom] is set to [Auto].
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Enlarging or reducing by the desired zoom ratio ([Zoom])

You can print the original image after it has been enlarged or reduced by the desired zoom ratio. 

The zoom ratio can be specified between 25% and 400% (in increments of 1%).

In [Zoom] of the [Basic] tab, specify the zoom ratio.
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Printing on paper of a special size ([Original Size])

A special sized original is printed on custom sized paper loaded in the Manual Feed Tray.

1 In [Original Size] of the [Basic] tab, select [Custom Size].

 In [Paper Size], select [Same as Original Size].

2 Specify the width and length as desired, then click [OK].

 Reference

  -  Load the custom sized paper in the Manual Feed Tray. For details on how to load paper into 

the Manual Feed Tray, refer to Chapter 5 "Loading Paper" in [User's Guide Introduction].

     When you are using the PCL driver, you can pre-register a custom size in the [Settings] 

tab. For details in the [Settings] tab, refer to P. 2-66.

Specifying the paper type ([Paper Type])

In [Paper Type] of the [Basic] tab, select the type of paper for printing.
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Specifying the paper tray ([Paper Tray])

In [Paper Tray] of the [Basic] tab, select the paper tray for printing.

 Note

  -  If you select [Auto], the paper tray for the paper you have selected in [Paper Size] and/or [Paper 

Type] is automatically selected.

Printing on postcards

Print the original on the postcard loaded in the Manual Feed Tray.

1 Set as follows on the [Basic] tab.

 [Original Size]: Select [4 x 6 Postcard].

 [Paper Size]: Select [Same as Original Size].

 [Paper Tray]: Select [Bypass Tray].

2 Execute printing.

  For information on how to load postcards, refer to Chapter 5 "Loading Paper" in [User's 

Guide Introduction].
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Printing multiple sets of copies

Specifying the number of copies ([Copies])

In [Copies] of the [Basic] tab, specify the number of copies you want to print.

 Reference

  -  When you print a large number of copies, use of the Proof Print function will prevent a 

large number of misprints being created, thereby reducing the amount of waste paper 

generated. For details, refer to P. 2-54.

Printing on a set basis ([Collate])

When the [Collate] check box on the [Basic] tab is selected, copies are output separately in a set-

by-set manner, for example, "Pages 1, 2, 3, 4, and 5", "Pages 1, 2, 3, 4, and 5", and then "Pages 1, 

2, 3, 4, and 5".
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Saving the number of printed sheets

Printing multiple pages on the same side of a single sheet ([Combination])

You can print multiple reduced size pages on the same side of a single sheet to reduce the number 

of pages to be printed.

In [Combination] of the [Layout] tab, select "N in 1". For example, when you select [9 in 1], the size 

of every set of nine pages is reduced and printed on the same side of one sheet.

If necessary, click [Combination Details] to set the page layout order and whether or not to input 

border lines between pages.

Settings Description

[Layout Order] Select the page layout order.

[Border] Select this check box to draw border lines between pages. 

In addition, select the type of border lines from [Frame] and [Line].
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Copying on both sides of paper ([2-Sided])

By using both sides of paper for printing, you can halve paper consumption. In [Print Type] of the 

[Layout] tab, select [2-Sided].

 Note

  - This function is available only for D202/D201.

Skipping blank pages ([Skip Blank Pages])

Skip blank pages contained in the original when printing the original. You can reduce the number of 

printed sheets.

In the [Layout] tab, select the [Skip Blank Pages] check box.

 Note

  - For some originals, blank pages are also printed.

  - This function is only available for the Windows printer driver (PCL/XPS).
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Adjusting the layout

Printing in a booklet format ([Booklet])

Sort pages of the original in booklet format to perform 2-sided printing in two-page spread.  

When the printed sheets are collectively folded in two, they are arranged in the page order like a book.

In [Print Type] of the [Layout] tab, select [Booklet].

If necessary, click [Booklet Details], then specify the binding position and whether or not to insert  

a border line between pages.

Settings Description

[Binding Direction] Select the binding position in booklet format.

[Border] Select this check box to draw border lines between pages.
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 Note

  - This function is available only for D202/D201.

  - This function is available only for the Windows printer driver.

Adding a margin on pages ([Binding Margin])

You can add a binding margin to each page to bind the printed sheets.

1 In the [Layout] tab, select the [Binding Margin] check box.

 In [Binding Position] in the [Layout] tab, specify the margin position.

2 Click [Binding Margin Settings].

3 Adjust the size of margin, then click [OK].



2-35

Printing in the Windows Environment

2

Settings Description

[Shift Mode] Select how the images are shifted for creating the margin.

[Front Side]/ 

[Back Side]

Specify the size of the margin on the front side.

When you print on both sides, specify the size of the margin on 

the back side. When the [Same value for front and back sides] 

check box is selected, a margin of the same size is created on 

both the front and back sides.

 Note

  - This function is available only for the Windows printer driver.

Rotating the image 180 degrees ([Rotate 180])

Print an image upside down. This function is available when printing on envelopes of which the 

loading direction cannot be changed.

In the [Layout] tab, select the [Rotate 180] check box.
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Adding a text or image to the original

Adding a water mark ([Watermark])

Print a text such as "NO REPRODUCTION" and "INTERNAL USE" on the center of all pages in a tint 

color. By printing a watermark, you can specify the handling policy of copied originals.

In the [Stamp/Composition] tab, select the [Watermark] check box. In addition, select the watermark 

you want to print.

 Note

  - This function is available only for the Windows printer driver.
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Registering or editing a watermark

This machine has several factory-set watermarks. However, you can register new watermarks or  

edit existing watermarks, if necessary.

1 In the [Stamp/Composition] tab, select the [Watermark] check box, and click [Edit].

2  Click [Add] and register the watermark data.

  To edit a registered watermark, select the watermark from the [Current Watermark] list,  

and edit the data.

  To delete a registered watermark, select the watermark from the [Current Watermark] list,  

and click [Delete].

Settings Description

[Watermark Name] Enter the name to be displayed in the watermark list (using up to 

30 characters).

[Watermark Text] Enter the text to be displayed as a watermark (using up to 30 

characters).

[Up]/[Down] Click these buttons to reorder items in the list. You can move 

frequently used watermarks to upper positions.

[Position] Specify the print position for the watermark.

 [X]/[Y]: Adjust the horizontal and vertical positions of the 

watermark. The values change as you move the slide bar.

 [Center]: Click this button to reset the watermark position to 

the center.

 [Angle]: Adjust the angle of the watermark.
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Settings Description

[Font Name] Select the font for the watermark.

[Size] Specify the font size for the watermark.

[Style] Select the font style for the watermark.

[Frame] Select the frame for the watermark.

[Text Color] Select the color of the watermark.

[Transparent] Select this check box to print the watermark in a translucent tone.

When this check box is cleared, the printed watermark obscures 

the background.

[1st Page Only] Select this check box to print the watermark only on the first page 

of the original.

[Repeat] Select this check box to repeatedly print the watermark on each page.

[Sharing] Select this check box to share the watermark with other users.

3 Click [OK].
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Composing an overlay image ([Print in Overlay])

You can recall an overlay image registered on the computer to print it on the original as a composite 

image. For details on how to register an overlay image on your computer, refer to P. 2-40.

In the [Stamp/Composition] tab, select the [Print in Overlay] check box, then select the overlay image 

to be composed on the original from the list.

If necessary, click [Edit] to add or delete overlay images. Alternatively, change the method of  

composing an overlay image.

Settings Description

[Select Overlay File] Add or delete an overlay image.

[Browse Files] Add an overlay image to the list.

[Delete] Delete the selected overlay image from the list.

[Change 2nd Page 

and Later]

Select this check box to change the overlay image to be printed on the 

second and subsequent pages of the original. In addition, from the list, 

select the overlay image you want to use.

[File Information] Displays information on the selected overlay image.

[Overlay Print Setting] Change the method to compose an overlay image, if necessary.

[Pages] Select the range of pages to compose an overlay image on.

[Overwrite] Select whether or not to overwrite an overlay image on the front 

side of the original or to compose an overlay image on the back 

side of the original.

 Note

  - This function is available only for the Windows printer driver.
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Creating an overlay image on the computer

In the [Stamp/Composition] tab, select the [Create Overlay File] check box, then print data to be 

registered as an overlay image to create an overlay file on the computer.

1 Create an original to be registered in an overlay image using application software.

2 In the [Stamp/Composition] tab, select the [Create Overlay File] check box.

3  In the application software, execute printing. 

The [Create Overlay File] window appears.

4  Enter the file name to save the file. 

The overlay file is saved on the computer. The saved overlay file is displayed on the [Stamp/

Composition] tab, and it can be used for overlay printing.

 Note

  - This function is available only for the Windows printer driver.
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Deterring unauthorized copying

Printing a concealed security watermark ([Copy Protect])

Print a text such as "Copy" or "Private" in the background pattern as concealed text.  

This function is called the Copy Protect function.

When a copy-protected  original is copied, the concealed security watermark appears on the entire 

page, thereby indicating that it is an unauthorized copy.

In the [Stamp/Composition] tab, select the [Copy Protect] check box.

If necessary, click [Edit] to specify the text to be printed and the format of the text. For details,  

refer to P. 2-41.

 Note

  - This function is available only for the Windows printer driver (PCL).

Configuring the print settings for Copy Protect

When printing a copy protect pattern on sheets, you can set the text to be printed and the format  

of the text, if necessary.

In the [Stamp/Composition] tab, select the [Copy Protect] check box, then click [Edit].

Settings Description

[Pattern] Select whether or not the text pattern is to be embossed or 

outlined when the original is subjected to unauthorized copying.

[Pattern Overwrite] Select whether or not to compose a copy protect pattern on the 

front or back side of the original.

[Background Pattern] Select the copy protect pattern from the background patterns 

registered on this machine.
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Settings Description

[Text/Background 

Color]

Select the color of the copy protect pattern.

[Characters] Select the text to be printed.

Selecting [<Custom>] can specify any text.

[Font Name] Select the font of the text to be printed.

[Text Size] Select the size of the text to be printed.

Inserting paper into the original

Inserting a front or back cover ([Front Cover] / [Back Cover])

Insert a cover sheet different from text sheets into the head and end of the original.

You can select a sheet that is different from text sheets (colored paper or thick paper) as a front 

cover, and collectively print the front cover with text pages.

1 In [Paper Tray] of the [Basic] tab, select the paper tray for printing text pages.

 You cannot select [Auto].

2 In the [Cover Mode] tab, select the [Front Cover] or [Back Cover] check box.

  If necessary, you can select whether or not to print the original on the inserted sheets or to 

leave them blank. When the inserted sheets are printed, the first page of the original is printed 

on the front cover and the last page of the original is printed on the back cover.

  In [Front Cover Tray] or [Back Cover Tray], select the paper tray for the paper to be used as 

the front cover or the back cover.
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Specifying the color and image quality

Selecting printing colors ([Select Color])

In [Select Color] of the [Quality] tab, select printing colors from Auto Color or Gray Scale.

 Note

  -  You can select [Black+Chinese Red] in [2 Color] of the PCL driver. This setting prints the 

gray areas in black, and the color areas in Chinese Red used in official Chinese documents.

Fine-tuning the image quality according to the original ([Quality Adjustment])

You can fine-tune the color image quality according to the original. For example, you can increase 

the vividness or reduce the color difference.

When you are using the PCL driver, you can adjust the brightness and contrast.

1 In the [Quality] tab, click [Quality Adjustment].
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Settings Description

[Color Matching] [Type]: Specify the type of the color profile appropriate for the 

type of the original.

[Brightness] (PCL only): Adjust the brightness of the printed 

image.

[Contrast] (PCL only): Adjust the contrast of the printed image.

[ICC Profile] (PS only) [RGB Color]: Specify the color space of the input RGB used for 

printing. 

[Destination Profile]: Specify the output profile used for printing.

[Simulation Profile]: Select the simulation profile of the input CMYK 

used for printing.

[CMYK Gray Treatment:]: Specify the printing method of plate K in 

the CMYK input data for simulation.

[Match Paper Color]: Specify whether or not to suit the background 

of paper for printing when carrying out a simulation.

[Other] [Pure Black]: Specify whether to print the gray areas of the original 

using only the black toner.

[Screen (Text)]: Specify the screen processing for the text element.

[Screen (Photo/Graphics)]: Specify the screen processing for the 

photo and graphic elements.

3 Click [OK].

 Reference

  -  When you are using the PS driver, you can manage the ICC profiles to be used. For details, 

refer to P. 2-49.
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Selecting the optimum color representation for the original ([Color Settings])

Select the optimum settings for the original to print it at the optimum image quality level.

Select one of the following processes according to the original to be printed; the process suitable 

for originals consisting primarily of text, the process suitable for photos, the process suitable  

for originals created with DTP (PCL only).

In [Color Settings] of the [Quality] tab, select the optimum color setting mode to fit the original.

Specifying the density of a graphic pattern ([Pattern])

In [Pattern] of the [Quality] tab, select the density of a graphic pattern.

 Note

  - This function is only available for the Windows printer driver (PCL/XPS).
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Specifying the compression ratio of a graphic image ([Image Compression])

In [Image Compression] in the [Quality] tab, select whether or not the quality or printing speed is 

preferred when the image data contained in the original is compressed.

 Note

  - This function is available only for the Windows printer driver (PCL).

  - You can set this function only when [Auto Color] or [2 Color] is selected in [Select Color].

Saving the toner consumption ([Toner Save])

Selecting the [Toner Save] check box in the [Quality] tab adjusts the printing density in order to  

reduce the amount of toner consumed.
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Sharpening the border between text etc. ([Edge Enhancement])

Sharpen the edges of images such as text in the table and graphics to improve legibility.  

In the [Quality] tab, select the [Edge Enhancement] check box.

 Note

  - This function is available only for the Windows printer driver (PCL).

Specifying the font processing method ([Font Settings])

Specify how the fonts are processed for printing.

1 In the [Quality] tab, click [Font Settings].
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2 Change how the fonts are processed for printing.

Settings Description

[Download Font 

Format]

Select a type of font to be downloaded from the computer to this 

machine.

[Use Printer Fonts] Select this check box to replace TrueType fonts with printer fonts 

during printing. Use of printer fonts increases the printing speed.

In normal printing operations, we recommend that you select this 

check box.

[TrueType Font 

Substitution Table] 

(PCL only)

Set this table when you want to specify the printer fonts that replace 

TrueType fonts.

From the list, select the TrueType font, then in [Printer Font to Use], 

select the printer font with which you want to replace the TrueType 

font.

3 Click [OK].

 Note

  -  If characters are garbled in an environment where the PCL driver is used, we recommend 

that you select [Bitmap] in [Download Font Format] and clear the [Use Printer Fonts] check 

box.

  - This function is available only for the Windows printer driver (PCL/PS).
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Using ICC Profiles (PS Only)

Specifying the ICC profiles for printing

Specify and print the ICC profiles registered in this machine with the printer driver.

   To use the new ICC profiles registered this machine, you need to add the ICC profiles to the 

printer driver in advance. For details, refer to P. 2-50.

1 In the [Quality] tab, click [Quality Adjustment].

2 Click the [ICC Profile] tab.

3 Specify the settings for [RGB Color], [Destination Profile], and [Simulation Profile].

 The ICC profiles registered in the printer driver can be selected.

4  Click [OK]. 

Color processing is performed according to the selected ICC profiles.
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Adding ICC profiles to the printer driver

To use the ICC profiles registered in this machine for printing, you need to add the ICC profiles to 

the printer driver in advance.

  To use this function, contact your service representative.

   To register ICC profiles in this machine, use Download Manager. For details on how to register 

ICC profiles in this machine, refer to the Help for Download Manager.

1 In the [Quality] tab, click [Quality Adjustment].

2 Click [Manage Profile].

  If the Download Manager has been installed and if you click [Download Manager], the Download 

Manager starts.

3 Click the tab and select a color profile type.



2-51

Printing in the Windows Environment

2

4  From the [Available Profile] list, select the profile you want to add to the printer driver, then click 

[Add Sel].

 The profile name can be changed in [Edit].

  If the profile is not displayed in the list, click [New], and enter [File Name] and [Profile Name]  

of the profile registered in this machine.

5  Click [OK]. 

The profile is added to [Driver Profile List].
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Printing Microsoft Excel/PowerPoint data

Printing multiple Excel sheets at one time

When multiple Microsoft Excel sheets with different print settings are printed at one time, this function 

prevents the sheets from being printed separately.

In the [Other] tab, check the [Excel Job Control] box.

 Note

  -  This function is only available for the Windows printer driver. However, this function may 

not be available depending on a specific environment or application software.

Composing and printing an image correctly in PowerPoint

The process executed when an overlay image is printed on a PowerPoint original where a white 

background is optimized. This function prevents the overlay image from being overwritten by the 

white background of the PowerPoint original.

In the [Other] tab, select the [Remove White Background] check box.
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 Note

  -  This function is only available for the Windows printer driver (PCL/XPS). However, this function 

may not be available depending on a specific environment or application software.

Preventing failure in printing thin lines ([Thin Line Support])

You can prevent thin lines from disappearing in reduced-size printing. In the [Other] tab, select  

the [Thin Line Support] check box.

 Note

  -  This is effective for thin lines such as table borders created in Excel, but not for thin  

lines used in illustrations.

  -  This function is only available for the Windows printer driver (PCL).
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5. Printing options

Making a Trial Printing ([Proof Print]) 

Proof Print

The Proof Print function is used when printing multiple copies. It allows the printer to output one 

copy and pause the printing operation before printing the remaining copies.

Because you can check the print result before starting to print the remaining copies from the Control 

Panel, this function is useful for preventing printing of a large number of misprints.

 Note

  - To use this function, contact your service representative.

How to print from the computer

1 In [Output Method] in the [Basic] tab, select [Proof Print].

2  Specify the number of copies, then execute printing. 

Only one copy is printed. Continue to "Operations on this machine".
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Operations on this machine

1  On the main screen of the copy mode, select [Print Function] by pressing the ▲/▼ key,  

then press the Select key.

2 Select [Proof Print] by pressing the ▲/▼key, then press the Select key.

3 Select the job to print by pressing the ▲/▼key, then press the Select key.

4 Select [Print] by pressing the ▲/▼key, then press the Select key.

5 If necessary, change the number of copies, then press the Select key.

 The remaining copies are printed.
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Printing Highly Confidential Documents ([Secure Print])

Secure Print

Secure Print is a function that saves print data in the built-in flash memory of this machine with  

a password. Because the data is not printed straight away, this function prevents printed materials 

from going missing or being left unattended.

To print data from the built-in flash memory, you need to enter the password; this function is  

particularly suitable for safely printing highly confidential documents.

 Note

  - To use this function, contact your service representative.

How to print from the computer

1 In [Output Method] on the [Basic] tab, select [Secure Print].

2 Enter the ID and password, then click [OK].

  If you always use the same ID and password, registering them in advance eliminates the 

need for entering them each time. For details, refer to P. 2-11.
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3  Execute printing.

  The print data is saved in the built-in flash memory of this machine. Continue to "Operations  

on this machine".

  You can issue a print instruction from the Control Panel before print data scanning on this 

machine is completed. However, printing is executed after print data scanning on this  

machine has been completed.

Operations on this machine

To print the saved data, you need to enter the password specified in the printer driver.

1  On the main screen of the copy mode, select [Print Function] by pressing the ▲/▼ key,  

then press the Select key.

2 Select [Secure Print] by pressing the ▲/▼ key, then press the Select key.

3 Enter the Secure Print ID specified when printing data from the computer.

4 Enter the password specified when printing data from the computer.

5 Select the job to print by pressing the ▲/▼ key, then press the Select key.

6 Select [Print] by pressing the ▲/▼ key, then press the Select key.

7 If necessary, change the number of copies, then press the Select key.

 Printing starts.
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Attaching authentication information

Printing when authentication is set

When printing a document in an environment where user authentication or account track is employed, 

you need to send the authentication information (user name and password) to this machine to execute 

printing. This requirement limits the users who can use this machine, preventing unauthorized use by a 

third party.

When this machine receives a print job from a user who is not permitted to print, or a print job that 

does not contain authentication information, this machine automatically discards the job.

 Note

  -  A print job that does not contain authentication information is a print job that is sent without 

correctly configuring the User Authentication/Account Track setting using the printer driver 

even though the User Authentication/Account Track setting is configured on this machine.

     The status in which the User Authentication/Account Track setting is not configured correctly 

means that the [Auto] check box of [Obtain Settings] is cleared and [User Authentication]/

[Account Track] of [Device Option] is set to [Disable] in the [Configure] tab of the [Properties] 

windows of the printer driver. If a print job is executed in this status by selecting [Print] in 

[Output Method] of the [Basic] tab at the time of printing, it is considered as a print job  

without authentication information.
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Operations required to use this function

In the [Configure] tab of the printer driver, check that the User Authentication/Account Track  

setting is correctly configured.

1 Display the [Properties] window of the printer driver.

 For information on how to display the [Properties] window, refer to P. 2-62.

2  In [Device Option] of the [Configure] tab, check that the User Authentication/Account Track 

setting is correctly configured for your operating environment.

  If it is not configured correctly, select [User Authentication] or [Account Track] from the list, 

then change the relevant setting in [Setting].

3 Click [OK].
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How to print from the computer

1 In the [Basic] tab, click [Authentication/Account Track]

2  When user authentication is enabled, select [Recipient User], then enter the user name and 

password.

  If access to this machine by public users (unregistered users) is allowed, you can select 

[Public User] and print data without entering the user name and password.

  If you always use the same user name and password, registering them in advance eliminates 

the need for entering them each time. For details, refer to P. 2-11.
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3 If account track is enabled, enter the account name and password.

  If you always use the same account name and password, registering them in advance  

eliminates the need for entering them each time. For details, refer to P. 2-11.

4 Click [OK].

  If a communication with this machine is established, you can click [Verify] to check the 

entered authentication information. Also, you can check the authentication information for 

errors before printing it.

5  Execute printing 

Printing starts successfully when the authentication information is judged correct.
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6. Printer driver setting items

[Properties] window of the printer driver

How to display the [Properties] window

The printer driver has two windows for configuring settings: the [Properties] window and the [Printing 

Preferences] window. This section describes the [Properties] window.

In the [Properties] window, you can configure settings for the optional environment of this machine 

or Windows functions. To display the [Properties] window, take the following steps:

1 Display the printer window.

 In Windows 8.1, click [ ] in the Start window, then click [Control Panel].

  In Windows 8, right-click the Start window, then click [All apps] - [Control Panel] - [Hardware 

and Sound] - [View devices and printers].

  In Windows Server 2012/Server 2012 R2, open the Start window, then click [Control Panel] - 

[Hardware] - [View devices and printers].

  In Windows 7/Server 2008 R2, open the Start menu, then click [Devices and Printers]. 

If [Devices and Printers] is not displayed, select [Control Panel] - [Hardware and Sound], 

and click [View devices and printers].
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  In Windows Vista/Server 2008, click the Start menu, and select [Control Panel] - [Hardware 

and Sound] - [Printers]. 

When [Control Panel] is displayed in Classic View, double-click [Printers].

  In Windows Server 2003, click the Start menu, then select [Printers and Faxes]. 

If [Printers and Faxes] is not displayed, select [Control Panel] - [Printers and Other Hardware] 

- [Printers and Faxes]. When [Control Panel] is displayed in Classic View, double-click 

[Printers and Faxes].
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2 Open the printer properties.

  In Windows 7/8/8.1/Server 2008 R2/Server 2012/Server 2012 R2, right-click the icon of the 

installed printer, and from [Printer properties], click the displayed printer name.

  In Windows Vista/Server 2003/Server 2008, right-click the icon of the installed printer, then 

click [Properties].

  The [Properties] window appears.

Tabs provided by Windows

The [General], [Sharing], [Port], [Advanced], [Color Management], and [Security] tabs are provided 

by Windows.

You can print a test page, configure printer sharing, configure printer ports, etc. For details, refer to 

the Windows manuals.
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Available operations in the [Configure] tab

You can specify which optional devices are installed on this machine using the [Configure] tab. 

You can automatically obtain information of this machine to manually configure settings.

Settings Description

[Device Option] The model name, options installed on this machine, and 

authentication settings of this machine are displayed.

When the settings of this machine cannot be obtained, you need 

to manually change the settings. Select the item to change from 

the list, and set a value in [Setting].

[Obtain Device 

Information]

Obtains information about which optional devices are installed on 

this machine by communicating with this machine.

In [Obtain Settings], set the method of obtaining the information on 

this machine.

[Obtain Settings] Configure the settings to obtain the information of this machine.

[Auto] Select this check box to automatically obtain the information of this 

machine.

[Destination 

Settings]

Set the communication method to get information from this machine.

 [Device which Connect with Printer Port]: Information is obtained 

from the printing port specified in the [Port] tab in the printer driver.

 [Specify IP Address or Printer Name]: Information is obtained by 

connecting to a device with the entered IP address or printer name.

[Software Tools] You can start up the software tools such as Web Connection.

 Note

  -  When [Auto] in [Obtain Settings] is enabled and the computer is unable to communicate 

with this machine, the computer takes a long time to display the [Properties] window or the 

[Printing Preferences] window.

  -  If you are using the machine from a Windows Server 2003 computer via USB connection, 

[Obtain Device Information] cannot be used.
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Available operations in the [Settings] tab

In the [Settings] tab, you can change the default settings for how confirmation messages are displayed 

as well as the window for inputting authentication information.

Settings Description

[EMF Spool] Select this check box when meta file (EMF) spooling is required 

in your own system environment.

[Display Constraint

Message]

Select this check box to display a message indicating that you have 

selected printer driver functions that cannot be used together.

[Display paper set 

in Print Server 

Properties]

Select this check box to display the paper sizes available in 

Windows when specifying paper size in the printer driver setting.

When using the PCL driver, this check box needs to be selected if 

you want to use the paper newly created in [Server Properties] on 

the printer screen.

[Authentication 

Settings]

Configure the User Authentication/Account Track settings.

 [Verify Authentication settings before printing]: Select 

this check box to enable the [Verify] button in the [User 

Authentication/Account Track] dialog box.

 [Popup Authentication Dialog when printing]: Select this check 

box to display the [User Authentication/Account Track] dialog 

box when starting printing. This option reminds you to enter 

the user name and password.

[My Tab Settings] Configure the display settings for [My Tab] when using [My Tab] 

of the printer driver.

 [Display My Tab]: Select this check box to use [My Tab].

 [Share My Tab]: Select this check box to share the settings in 

[My Tab]. 

When the printer driver is installed in a client by specifying the 

shared printer on the server, the [My Tab] settings configured 

on the server are applied to the client.

 [Prohibit Editing]: Select this check box to prohibit the clients 

from editing [My Tab].

 [Display Note]: Select this check box to display notes in [My 

Tab] when [MyTab] is opened.

[Save Custom Size] If you print on odd size paper, specify the size to register the 

paper.

The registered paper size can be selected from [Original Size] in 

the [Basic] tab.
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 Note

  - [EMF Spool] is a function of the PCL driver.

  - [Save Custom Size] is a function of the PCL driver.

  -  The procedure for opening [Server Properties] is as follows:  

In Windows 7/8/8.1/Server 2008 R2/Server 2012/Server 2012 R2, select a different printer, 

and click [Print Server Properties] on the toolbar. 

In Windows Vista/Server 2008, right-click on the area that has nothing displayed in the 

[Printers] window, click [Run as administrator] - [Server Properties]. 

In Windows Server 2003, click the [File] menu, then [Server Properties].

  -  If you set the function layout on the [My Tab] using the Driver Packaging Utility, each  

user can use those functions in the same layout. 

When creating a driver package with Driver Packaging Utility, move the printer driver that  

is used as a source of the package to the desired position in My Tab. In [My Tab Settings], 

select the [Display My Tab] and [Share My Tab] check boxes, then configure Driver  

Packaging Utility to copy the printer settings. For details on the Driver Packaging Utility 

settings, refer to the Driver Packaging Utility Help.

 Reference

  - For details on how to edit [My Tab], refer to P. 2-24.
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[Printing Preferences] window of the printer driver

How to display the [Printing Preferences] window

The printer driver has two windows for configuring settings: the [Properties] window and the [Printing 

Preferences] window. This section describes the [Printing Preferences] window.

The [Printing Preferences] window has multiple tabs on each of which related functions are grouped 

to enable you to configure print functions unique to this machine. To display the [Printing Preferences] 

window, take the following steps:

1 Display the printer window.

 In Windows 8.1, click [ ] in the Start window, then click [Control Panel].

  In Windows 8, right-click the Start window, then click [All apps] - [Control Panel] - [Hardware 

and Sound] - [View devices and printers].

  In Windows Server 2012/Server 2012 R2, open the Start window, then click [Control Panel] - 

[Hardware] - [View devices and printers].

  In Windows 7/Server 2008 R2, open the Start menu, then click [Devices and Printers]. 

If [Devices and Printers] is not displayed, select [Control Panel] - [Hardware and Sound], 

and click [View devices and printers].
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  In Windows Vista/Server 2008, click the Start menu, and select [Control Panel] - [Hardware 

and Sound] - [Printers]. 

When [Control Panel] is displayed in Classic View, double-click [Printers].

  In Windows Server 2003, click the Start menu, then select [Printers and Faxes]. 

If [Printers and Faxes] is not displayed, select [Control Panel] - [Printers and Other Hardware] 

- [Printers and Faxes]. When [Control Panel] is displayed in Classic View, double-click 

[Printers and Faxes].
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2 Open [Printing Preferences].

  In Windows 7/8/8.1/Server 2008 R2/Server 2012/Server 2012 R2, right-click the icon of the 

installed printer, and from [Printing preferences], click the displayed printer name.
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  In Windows Vista/Server 2003/Server 2008, right-click the icon of the installed printer,  

and click [Printing Preferences].

 The [Printing Preferences] window of the printer appears.

 Note

  -  The print settings changed here are registered as default values. When you want to temporarily 

change settings to print from application software, click [Properties] (or [Preferences]) in the 

[Print] window to open the [Printing Preferences] window.
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Items common to each tab

The following explains the commonly used settings and buttons in each tab.

Settings Description

[Favorite Setting] You can register the current print settings as a favorite and recall 

it when executing printing.

For details on the [Favorite Setting], refer to P. 2-23.

View Selecting [Paper View] displays a sample page layout based on the 

current settings for checking the output result image.

Selecting [Printer View] displays a printer figure showing the current 

machine configuration.

[Printer Information] Click this button to start Web Connection and check the printer 

information. This button is enabled only when your computer can 

communicate with this machine.

[OK] Applies the changes made to the settings and closes the setting 

window.

[Cancel] Discards (or cancels) the current changes and closes the setting 

window.

[Help] Displays the help for each item in the window.

[Default] Initializes the current settings.

Available operations in [Advanced]

[Advanced] is a tab to configure detailed settings for PostScript. This function is only available for 

the PS driver.

Settings Description

[Advanced Printing

Features:]

Select whether or not to enable the booklet print setting.

[PostScript Options] Configure the PostScript option setting.

 [PostScript Output Option]: Select the method to output a 

PostScript file.

 [Send PostScript Error Handler]: Select whether or not to print a 

report when a PostScript error has occurred.

 [Mirrored Output]: Select whether or not to print an image in 

mirror-reversed mode.

[PostScript Pass 

through]

Select whether or not to allow the application to print data directly 

without using the printer driver.
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 Note

  -  [Advanced Printing Features:] is displayed when the [Enable advanced printing features] 

check box is selected in the [Advanced] tab of the [Properties] window.

Available operations in [My Tab]

[My Tab] allows you to customize the display contents.

You can gather setting items from difference tabs and place them in [My Tab].  

Registering frequently used setting items in [My Tab] allows you to change settings in one tab, 

without switching among multiple tabs.

For details on how to edit [My Tab], refer to P. 2-24.

Settings Description

[More Details] Click this button to display the Help of [My Tab].

[Do not show again] Select this check box if you do not want to display the comment 

field containing [More Details].

[Edit My Tab] Click this button to register or delete the functions displayed in 

[My Tab].

Available operations in [Basic]

In the [Basic] tab, you can configure basic settings about paper or printing. Functions that are  

frequently used in normal printing are placed in this tab.

Settings Description

[Original Orientation] Specify the orientation of the original created in application 

software.

If the setting in the printer driver differs from the one specified in 

the application software, correct the setting.

[Original Size] Select the size of the original created in application software.

If the setting in the printer driver differs from the one specified in the 

application software, correct the setting.

To print on custom sized paper, select [Custom Size] and specify 

the width and length. For details, refer to P. 2-28.
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Settings Description

[Paper Size] Select the size of paper for printing.

If the size of the paper is different from that of the original size, 

and if [Zoom] is set to [Auto], the original is sent by enlarging or 

reducing it according to the selected paper size.

To print on custom sized paper, select [Custom Size] and specify 

the width and length. For details, refer to P. 2-28.

Note

 -  [12 x 18] in Paper Size is equivalent to 304.8 x 457.2 mm that 

is slightly larger than A3.

[Zoom] Select how the print image is enlarged or reduced.

 [Auto]: The image is enlarged or reduced according to the size 

of the paper specified in [Paper Size].

 [Manual]: The image is enlarged or reduced by the specified 

ratio (25 to 400%).

[Paper Tray] Select the paper tray for the printing paper.

When you select [Auto], the tray containing the paper selected in 

[Paper Size] and/or [Paper Type] is automatically used.

[Paper Type] Select the paper type used for printing.

[Output Method] Select the method to use to print the original from this machine.

[Print] Select this option to print normally.

[Secure Print] Select this option to print highly confidential documents. Printing is 

allowed when the ID and password are entered on this machine.

For details, refer to P. 2-56.

[Proof Print] Select this option to print a large number of copies. This machine 

prints only one copy and waits for the user's command before 

printing the remaining copies. For details, refer to P. 2-54.

[User Settings] When you have selected [Secure Print] in [Output Method], enter 

the required information.

[Authentication/

Account Track]

When user authentication or account track is employed, enter the 

user name or account name and the password. For details, refer 

to P. 2-58.

[Copies] When printing multiple sets of copies, specify the number of sets.

[Collate] When printing multiple sets of copies, select this check box to 

output sets of copies one by one.

When this check box is cleared, the first page of the original is 

printed on as many sheets as the number specified in [Copies], 

and then each of the subsequent pages is printed in this manner.
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Available operations in the [Layout] tab

In the [Layout] tab, you can configure layout settings for printing. You can combine pages or adjust 

print positions.

Settings Description

[Combination] Select how the original pages are combined on sheets.

 [2 in 1]/[4 in 1]/[6 in 1]/[9 in 1]/[16 in 1]: 

Multiple pages are reduced and printed on the same side of 

one sheet. For example, when you select [9 in 1], the size of 

every set of nine pages is reduced and printed on the same 

side of one sheet.

If necessary, click [Combination Details] to configure detailed 

settings about page combination.

[Combination]: Select the page combination.

 [Layout Order]: When you have selected "N in 1" in [Combination], 

select the order of pages in the layout.

 [Border]: When you have selected "N in 1" in [Combination], 

select this check box if you want to draw border lines between 

pages. In addition, select the type of border lines.

[Rotate 180] Select this check box to rotate the original 180 degrees and print it.

[Skip Blank Pages] 

(PCL/XPS)

Select this check box to exclude blank pages in the original from 

the pages to be printed.

[Print Type] Select the print sides of paper.

 [1-Sided]: The original is printed on one side of a sheet of 

paper.

 [2-Sided] (D202/D201): The original is printed on both sides 

of paper.

 [Booklet] (D202/D201): The original is printed in booklet 

format.

Original pages are sorted and printed on both sides of sheets in 

two-page spread mode. When the printed sheets are collectively 

folded in two, they are arranged in the page order like a book. 

If necessary, click [Booklet Details], then specify the binding 

position and whether or not to draw border lines.

[Binding Position] Select the binding position.
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Settings Description

[Binding Margin] Select this check box to provide a margin on printed sheets.

Click [Binding Margin Settings] to specify the size of the margin in 

detail.

 [Shift Mode]: Select how the images are shifted for creating 

the margin.

 [Front Side]: Specify the size of the margin on the front side.

 [Back Side]: When you print on both sides, specify the size of 

the margin on the back side. When the [Same value for front 

and back sides] check box is selected, a margin of the same 

size is created on both the front and back sides.

Available operations in the [Cover Mode] tab

In the [Cover Mode] tab, you can insert covers and pages.

Settings Description

[Front Cover] Select this check box to insert and print on a front cover. 

In [Front Cover Tray], select the paper tray for the front cover. 

Then, select whether or not to print on the inserted front cover.

 [Blank]: Nothing is printed on the inserted front cover.

 [Print]: The first page of the original is printed on the inserted 

front cover. You can set this option when you have selected 

anything other than [Auto] in [Paper Tray] in the [Basic] tab.

[Back Cover] Select this check box to insert and print on a back cover. In 

[Back Cover Tray], select the paper tray for the back cover. 

Then, select whether or not to print on the inserted back cover.

[Blank]: Nothing is printed on the inserted back cover.

 [Print]: The first page of the original is printed on the inserted 

front cover. You can set this option when you have selected 

anything other than [Auto] in [Paper Tray] in the [Basic] tab.
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Available operations in the [Stamp/Composition] tab

In the [Stamp/Composition] tab, you can configure settings for adding text or an image to the original.

Settings Description

[Watermark] Select this check box to print a watermark (text stamp) on the 

original. In addition, from the list, select the watermark you want 

to print.

Clicking [Edit] allows you to register or edit a watermark. 

For details, refer to P. 2-37.

[Create Overlay File] Data created in application software is saved in the shared folder 

on the network as an overlay image to be composed on the 

original. For details, refer to P. 2-40.

[Print in Overlay] Select this check box to compose the created overlay image on 

the original when printing. For details, refer to P. 2-39.

[Copy Protect] (PCL 

only)

Select this check box to print a text such as "Copy" or "Private" in 

the background pattern as concealed text.

When you click [Edit], you can configure detailed settings such 

as Copy Protect printing items or the printing method. For details, 

refer to P. 2-41.

Available operations in the [Quality] tab

In the [Quality] tab, you can configure settings for the image quality of the original. You can specify 

colors, image processing, and font processing.

Items that can be specified vary depending on your printer driver.

Settings Description

[Select Color] Select colors for printing.

 [Auto Color]: The color mode is automatically selected 

according to the original color.

 [Gray Scale]: The original is printed in black and white regardless 

of whether or not the original is in color or in black and white.

 [2 Color] (PCL only): The original is printed in the two 

specified colors. The gray areas and color areas of a color 

original are printed using combinations of the colors specified 

in [2 Color].

[Quality Adjustment] The image quality is fine tuned according to the original.

When you are using the PS driver, you can manage the ICC 

profiles with [Quality Adjustment]. For details, refer to P. 2-49.
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Settings Description

[Color Settings] Select the optimum color setting mode for the original.

 [Document]: The color setting suitable for originals containing 

multiple elements, such as text, graphs, figures, and photos, 

is applied.

 [Photo]: The color setting that prioritizes the image quality is 

applied.

 [DTP] (PCL): The color setting suitable for originals containing 

both text and figures is applied. It reproduces exactly what is 

on the display.

[Pattern] (PCL/XPS) Select the pattern density.

[Image Compression] 

(PCL only)

Select the compression mode for the image data contained in the 

original.

 [Best Quality]: The process prioritizes quality. Quality is 

improved, but printing takes a long time.

 [High Compression]: The process prioritizes speed.  

The printing time is shortened, but the printing quality is 

deteriorated.

 [High/Smaller Image Size]: The image data is compressed 

and reduced, and the process prioritizes speed. For some 

image data, its print time can be reduced than the [High 

Compression] mode.

[Toner Save] Select this check box to save the amount of toner consumed. 

The printing density is reduced.

[Edge Enhancement] 

(PCL)

Select this check box to sharply print small or faint text. Sharpen 

the edges of images such as text in the table and graphics to 

improve legibility.

[Font Settings] (PCL/

PS)

Specify how to process texts.

Select a type of font to be downloaded from the computer to this 

machine. Also specify whether or not replace the TrueType fonts 

by printer fonts when printing.

If characters are garbled in an environment where the PCL driver 

is used, we recommend that you select [Bitmap] in [Download 

Font Format] and clear the [Use Printer Fonts] check box.
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Available operations in the [Other] tab

In the [Other] tab, you can check the driver version and configure print settings for application software.

Settings Description

[Excel Job Control] Select this check box to print multiple Microsoft Excel sheets with 

different page settings at one time.

When multiple sheets with different page settings are printed 

at one time, the sheets may be separated into single-sheet 

jobs depending on the data contained. This function avoids job 

separation as much as possible.

[Remove White 

Background] (PCL/

XPS)

Select this check box to superimpose an overlay image on 

Microsoft PowerPoint data.

White areas are removed so that the white background of the 

PowerPoint data does not hide the overlay image. 

Clear this check box to print the original as is without removing 

the background.

[Thin Line Support] 

(PCL only)

Select this check box to perform reduced-size printing. 

This function prevents thin lines from disappearing.

This is effective for thin lines such as table borders created in 

Excel, but not for thin lines used in illustrations.

[Check Driver Version] The version of the printer driver is displayed.

 Note

  -  [Excel Job Control] and [Remove White Background] are not available depending on a 

specific environment or application software.

  -  You can change the [Excel Job Control] setting only when the printer driver setting dialog 

box is displayed on the [Printers] ([Devices and Printers] in Windows 7/8/8.1/Server 2008 

R2/Server 2012/Server 2012 R2 and [Printers and Faxes] in Windows Server 2003) window.
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7. Uninstalling the printer driver
Using the deletion program

If the printer driver was installed using the installer, the uninstallation function for the printer driver is 

also installed.

  Administrator privileges are required to perform this task.

1 Start the deletion program.

   From the Start menu, click [All Programs] (or [Programs]) - [Sindoh] - model name of this 

machine - [Uninstall Printer Driver].

   In Windows 8.1, click [ ] in the Start window, select [Control Panel] - [Programs], then 

click [Uninstall a program]. Double-click the driver to be uninstalled in the list.

   In Windows 8, right-click the Start window, select [All apps] - [Control Panel] - [Programs], 

then click [Uninstall a program]. Double-click the driver to be uninstalled in the list.

   In Windows Server 2012/Server 2012 R2, open the Start window, then click [Control Panel] - 

[Programs] - [Uninstall program]. Double-click the driver to be uninstalled in the list.

2 Select the printer driver you want to uninstall, then click [Uninstall]. 

  Follow the subsequent on-screen instructions.

3  If the dialog box prompting to restart the computer appears, click [OK]. 

Uninstallation of the printer driver is then completed.
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Uninstall using the installer

If you have installed the driver using the installer, you can use the installer to uninstall the driver.

  Administrator privileges are required to perform this task.

1 Insert the printer driver CD-ROM into the CD-ROM drive of the computer.

  Make sure that the installer starts, then proceed to Step 2.

  If the installer does not start, open the printer driver folder on the CD-ROM, double-click 

[Set- up.exe], then go to Step 3.

2  Click [Printer]. 

The printer driver installer starts.

3 Click [AGREE] in the license agreement window.

4 Check the contents of the [Readme] window, then click [Next].

5 Select [Uninstall Printer Driver], then click [Next].

6 Select the printer driver you want to uninstall, then click [Uninstall].

 Follow the subsequent on-screen instructions.

7  If a dialog box prompting you to restart the computer appears, click [OK] to restart the computer. 

Uninstallation of the printer driver is then completed.
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1. Preparation for printing (Bonjour connection)

Overview

Before using this machine as a printer, you need to install the printer driver on your computer and 

add the printer to your computer.

This section describes preparations required to carry out printing on this machine by Bonjour 

(Rendezvous) connection that is supported in Mac OS X 10.3 or later.

 Note

  -  The Bonjour technology enables you to configure the network settings for networked  

devices and find and use services without the need for configuring special settings.

  - In Mac OS X 10.3, Bonjour is called Rendezvous.

Before setting up the computer (for administrators)

1 Connecting this machine to the network

Checking a LAN cable for connection

2 Configuring the Bonjour settings

Enabling Bonjour

Setting a printer name (Bonjour name)

 Enter the name of this machine to be displayed as the name of a connected device. 

3 Preparation finished

Checking a LAN cable for connection

Check that a LAN cable is connected to the LAN port of this machine. For details on the cable  

connection port, refer to P. 1-4.

Configuring the Bonjour settings

Enable Bonjour. (You can use this function with the default settings unless otherwise requested.) 

In addition, enter the name of this machine (Bonjour name) to be displayed as the name of a  

connected device.

For details on how to configure settings, refer to Chapter 1 “Using Web Connection” in [User’s 

Guide Applied Functions].
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Setting up the computer

1 Preparing the printer driver

 Preparing the printer driver CD

 For the CD, contact the administrator of this machine.

Checking the operating systems supported by the printer driver

 Check that your computer meets the operating environment requirements of the printer driver.

2 Installing the printer driver to the computer

 Installing the printer driver using the installer

  Insert the Driver CD disk into the drive, and install the software by following the onscreen  

instructions.

 Adding the printer

 Add the printer automatically detected by Bonjour to the computer.

3 Preparation finished

Preparing the printer driver CD

The following CDs are supplied with this machine. The printer drivers are included on the Driver CD.

CD-ROM Description

Driver CD Contains Windows printer driver (PCL/PS/XPS), Mac OS printer 

driver, Linux printer driver, and TWAIN driver. This also contains 

the page for downloading utility software.

User Manual CD Contains user’s guides.

Checking the operating systems supported by the printer driver

The following lists the printer drivers included on the CD supplied with this machine and the 

supported operating systems.

Printer driver
Page description 

language
Supported operating systems

PostScript PPD driver 

(PS- PPD)

PostScript 3 Emulation Mac OS X (10.3.x, 10.4.x, 10.5.x, 

10.6.x, 10.7.x, 10.8.x, 10.9.x)



Printing in the Mac OS Environment

3-4

Installing the printer driver

Install the printer driver using the installer.

   Before installation, exit all application software programs that are running.

1 Mount the Driver CD disk into the CD drive of the computer.

2 Open the folder on the CD that contains the desired printer driver.

   Select the folder according to the printer driver, operating system, and language to be used.

3 Copy the driver file onto the desktop according to the Mac OS X version.

 Mac OS X 10.3: model name of this machine_103104.pkg

 Mac OS X 10.4: model name of this machine_103104.pkg

 Mac OS X 10.5: model name of this machine_105.pkg

 Mac OS X 10.6: model name of this machine_106.pkg

 Mac OS X 10.7: model name of this machine_107108.pkg

 Mac OS X 10.8: model name of this machine_107108.pkg

 Mac OS X 10.9: model name of this machine_109.pkg

  In Mac OS X 10.5 or later, the driver folder varies depending on the paper size.  

Select the appropriate folder to suit your environment. 

To mainly use the metric-based paper size such as A4 size: “WW_A4” folder 

To mainly use the inch-based paper size such as letter size or 8 1/2 x 11: “WW_Letter” folder

4  Double-click the file copied onto the desktop. 

The printer driver installer starts.

5  Click [Continue] following the instructions on the pages that follow until the [Install] page  

appears.

    When the name and password prompt appears during the procedure, enter the administrator 

name and password.

6  Click [Install]. 

The printer driver is installed on the computer.

7  Click [Close]. 

The installation process of the printer driver is then completed. Then, add the printer to the 

computer.
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Configuring connection using Bonjour (Mac OS X 10.4 or later)

Add the printer automatically detected by Bonjour to the computer.

1 Select [System Preferences] in the Apple menu.

2 Click the [Print & Fax] icon.

  In Mac OS X 10.7/10.8, click the [Print & Scan] icon. In Mac OS X 10.9, click the [Printers  

& Scanners] icon.

3 Click [+] in the lower left of the screen.

 In Mac OS X 10.4/10.5/10.6, go to Step 4.

  In Mac OS X 10.7/10.8/10.9, if a target printer name is found in the list displayed by clicking 

[+], select it. When a printer driver is selected automatically, the printer addition is completed. 

If a target printer name is not found, select [Add Other Printer or Scanner] or [Add Printer  

or Scanner], and go to Step 4.

4  Click [Default]. 

Connected printers are detected.

 If no printers are detected, restart this machine.

5 From the list of [Name] or [Printer Name], select the desired printer for a Bonjour connection.

  To check the printer name, select [Network] - [Bonjour Setting] in the administrator mode of 

Web Connection.

  By default, ( ) at the end of the printer name corresponds to the last three bytes of the MAC 

address.

 The printer driver for the selected printer is displayed in [Use:] or [Print Using:].
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 When the printer driver is displayed, go to Step 7.

 When the printer driver is not correctly displayed, go to Step 6.

6 Manually select the printer driver.

  In Mac OS X 10.9, select [Select Software] from [Use:], then click the driver of the desired 

printer from the list that is displayed in another window.

  In Mac OS X 10.6/10.7/10.8, select [Select Printer Software] from [Use:] or [Print Using:], 

then click the driver of the desired printer from the list that is displayed in another window.

  In Mac OS X 10.5, select [Select a driver to use] in [Print Using:], then click the driver of the 

desired printer from the list.

  In Mac OS X 10.4, select [Sindoh] in [Print Using:], and then click the driver of the desired 

printer from the list.

7  Click [Add]. 

The addition process of the printer is then completed. Then, proceed to the [Installable Options] 

window to configure the optional environment for this machine. For details, refer to P. 3-8.
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Configuring connection using Rendezvous (Mac OS X 10.3)

Add the printer automatically detected by Rendezvous to the PC.

1  From [Macintosh HD] (hard disk of the system) - [Applications] - [Utilities], double-click 

[Printer Setup Utility] or [Print Center] to open it.

2  When the [You have no printers available.] window appears, click [Add]. When the [Printer List]  

appears, click [Add].

   If available printers have already been specified, the [You have no printers available.]  

window does not appear.

3  Select [Rendezvous] as the connection method. 

Connected printers are detected.

  If no printers are detected, restart this machine.

4 From the [Name] list, select the desired printer for Rendezvous connection.

  To check the printer name, select [Network] - [Bonjour Setting] in the administrator mode  

of Web Connection.

  By default, ( ) at the end of the printer name corresponds to the last three bytes of the MAC 

address.

5 Manually select the printer driver.

  In [Printer Model:], select [Sindoh], then click the driver of the desired printer from the model 

list.

6  Click [Add]. 

The addition process of the printer is then completed. Then, proceed to the [Installable Options] 

window to configure the optional environment for this machine. For details, refer to P. 3-8.
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Initializing the printer driver

Configuring the optional environment of this machine

When you use this machine for the first time, properly configure the printer driver so that it contains 

information such as the options installed on this machine.

1 Open [System Preferences] in the Apple menu, then click the [Print & Fax] icon.

  In Mac OS X 10.7/10.8, click the [Print & Scan] icon. In Mac OS X 10.9, click the [Printers & 

Scanners] icon.

  In Mac OS X 10.3, select [Macintosh HD] (system hard disk) - [Applications] - [Utilities], 

then double-click [Printer Setup Utility] or [Print Center] to open it.

2 Display the [Printer Information] window.

  In Mac OS X 10.5/10.6/10.7/10.8/10.9, click [Options & Supplies]. In Mac OS X 10.4, click 

the [Printer Setup] icon.

   For the [Printer Setup Utility]/[Print Center] window, click [Show Info] of the [Printer] menu.

3 Display the [Installable Options] window.

 In Mac OS X 10.9, click [Options].

 In Mac OS X 10.5/10.6/10.7/10.8, click [Driver].

 In Mac OS X 10.3/10.4, select [Installable Options].

4 Change the settings according to the options installed on this machine.

    For details of the setting items, contact your service representative.

5 Click [OK] or [Apply Changes] to close the [Printer Information] window.



3-9

Printing in the Mac OS Environment

3

Changing the default print settings

In the [Page Setup] window of the printer driver, you can change the default settings for paper and 

zoom ratio.

1 Display the [Page Setup] window of the printer driver.

 For information on how to display the [Page Setup] window, refer to P. 3-29.

2 Change the settings, and select [Save As Default] from [Settings:].
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2. How to print

Printing operation flow

1 Open data of the original using the application software. From the [File] menu, select [Print].

2 Check that the desired printer is selected in [Printer:].

 The [Print] dialog box varies depending on the application software.

3 Specify the print range and the number of copies to print.

 In Mac OS X 10.7/10.8/10.9, if the setting items (1) are not displayed, click [Show Details].

  In Mac OS X 10.5/10.6, if the setting items (1) are not displayed, click  on the right side of 

[Printer:].

1

2

4 If necessary, switch the menu of application names (2) and change the print settings.

   The print settings you have changed here return to the default values when you exit the  

application software. This is useful to register frequently used print settings as presets.  

For details, refer to P. 3-11.

5  Click [Print]. 

Printing is executed.
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Registering frequently used print settings

You can register the current print settings as a preset and recall it when executing printing.

When you register a frequently used combination of print settings as a preset, you can easily  

apply all of those settings just by selecting the combination from the presets, even if the  

combination is complicated as it contains settings on multiple menus.

1 Display the [Print] window of the printer driver.

   For information on how to display the [Print] window, refer to P. 3-30.

2  Change the print settings, and select [Save As] or [Current Print Settings as Preset] from [Presets:].

3  Enter the name of the print setting. 

The saved setting can be recalled from [Presets:]. Use a name that helps you easily identify  

the preset.
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3. Useful printing functions

Changing the paper size or type

Enlarging or reducing by the desired zoom ratio ([Scale:])

You can print the original image after it has been enlarged or reduced by the desired zoom ratio.  

In [Scale:] of [Page Attributes], specify the zoom ratio.

Printing on custom size paper ([Page Setup])

A special sized original is printed on custom sized paper loaded in the Manual Feed Tray.

In [Page Attributes] under [Paper Size:], select [Manage Custom Sizes], and specify the desired 

width and length.

1 From the [File] menu, click [Page Setup] (or [Paper Setup]).

  In Mac OS X 10.5 or later, you can configure the same setting in [Paper Size:] in the [Print] 

window.

2 Open the window for registering a custom size.

 In Mac OS X 10.4 or later, select [Manage Custom Sizes] from the Paper Size list.

 In Mac OS X 10.3, select [Custom Paper Size] from [Settings:].

3 Click [+] (Mac OS X 10.4 or later) or [Add] (Mac OS X 10.3).

4 Enter the name of the paper size you are registering.

 Be sure to use paper size names other than existing names, such as A4 and Custom.

5 Specify the width and length as desired.

    If necessary, set the top, bottom, right, and left margins of the paper in [Non-Printable 

Area:] or [Printer Margins:].
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6  Click [OK] (Mac OS X 10.4 or later) or [Save] (Mac OS X 10.3). 

 This saves the custom paper size, which can be selected from the [Paper Size:] drop-down  

list in [Page Attributes].

 Reference

  -  To print on custom sized paper, use Manual Feed Tray. For details on how to load paper  

into the Manual Feed Tray, refer to Chapter 5 “Loading Paper” in [User’s Guide Introduction].

Specifying the paper type ([Paper Type:])

In [Paper Type:] of the [Paper Tray], select the type of paper for printing.
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Specifying the output tray ([Output Tray:])

In [Output Tray:] in [Paper Tray], select the output tray for printing.

Printing multiple sets of copies

Specifying the number of copies ([Copies:])

In [Copies:] of the [Print] window, specify the number of copies you want to print.

 Note

  - Mac OS X 10.3/10.4, specify the number of copies in [Copies & Pages].

 Reference

  -  When you print a large number of copies, use of the Proof Print function will prevent a 

large number of misprints being created, thereby reducing the amount of waste paper 

generated. For details, refer to P. 3-23.
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Printing on a set basis ([Collate])

When the [Collate] check box on the [Output Method] is selected, copies are output separately in 

a set-by-set manner, for example, “Pages 1, 2, 3, 4, and 5”, “Pages 1, 2, 3, 4, and 5”, and then 

“Pages 1, 2, 3, 4, and 5”.

Saving the number of printed sheets

Copying on both sides of paper ([2-Sided])

By using both sides of paper for printing, you can halve paper consumption.

In [Print Type:] of the [Layout / Finish], select [2-Sided]. Also, in [Binding Position:], select the 

binding position.

 Note

  - The 2-sided print function is available only for D202/D201.
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Printing multiple pages on the same side of a single sheet ([Pages per Sheet:])

You can print multiple reduced size pages on the same side of a single sheet to reduce the number 

of pages to be printed.

In [Pages per Sheet:] of [Layout], specify how many pages are to be printed on the same side of 

one sheet. For example, when you select [9], every set of nine pages is reduced and printed on the 

same side of one sheet.

If necessary, specify the paging order in [Layout Direction:], then select whether or not to insert a 

border line between pages in [Border:].

Adjusting the layout

Reversing the left and right sides ([Flip horizontally])

Reverse the left and right sides of a print image to make prints. In [Layout], select the [Flip horizontally] 

check box.

 Note

  - This function is available only for Mac OS X 10.6/10.7/10.8/10.9.
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Rotating a print image 180 degrees ([Rotate 180])

Print an image upside down. This function is available when printing on envelopes of which the 

loading direction cannot be changed.

In [Layout / Finish], select the [Rotate 180] check box.

Inserting a paper into the original

Inserting a front or back cover ([Front Cover:]/[Back Cover:])

Insert a cover sheet different from text sheets into the head and end of the original.

You can select a sheet that is different from text sheets (colored paper or thick paper) as a front 

cover, and collectively print the front cover with text pages.

1 In [Output Tray:] in [Paper Tray], select the paper tray for printing the body.

 You cannot select [Auto].

2 In [Cover Mode], select the [Front Cover:] and [Back Cover:] check boxes.

   If necessary, you can select whether or not to print the original on the inserted sheets or to 

leave them blank. When the inserted sheets are printed, the first page of the original is printed 

on the front cover and the last page of the original is printed on the back cover.

 Select the trays for paper to be inserted as the front and back covers.
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Printing a message on a cover page ([Cover Page])

Print a message such as [Confidential] or [Secret] on a cover page.

In [Print Cover Page:] of [Cover Page], select whether or not to print a cover page at the head or 

end of the document, then specify the type of the message to be printed in [Cover Page Type:].

To print billing information, enter the information to be printed in [Billing Info:].

Specifying the color and image quality

Selecting printing colors ([Select Color:])

Select colors for printing. For the color functions, [Auto Color] which prints according to the colors 

of the original, and [Gray Scale] are available.

In [Select Color:] in [Quality], select a color mode for printing.
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Saving the toner consumption ([Toner Save])

Selecting the [Toner Save] check box in the [Quality] adjusts the printing density in order to reduce 

the amount of toner consumed.

Selecting the optimum color representation for the original ([Color Settings:])

Select the optimum settings for the original to print it at the optimum image quality level.

Select one of the following processes according to the original to be printed; the process suitable 

for originals consisting primarily of text, the process suitable for photos.

In [Color Settings:] in [Quality], select the optimum color setting mode to fit the original.
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Using ICC Profiles

Specifying the ICC profiles for printing

Specify and print the ICC profiles registered in this machine with the printer driver.

   To use the new ICC profiles registered this machine, you need to add the ICC profiles to the 

printer driver in advance. For details, refer to P. 3-21.

1 In [Quality], click [Quality Adjustment].

2 The image quality is fine tuned according to the original.

Settings Description

[Text] [Photo] [Figure/

Table/Graph]

Configure a color setting for each Text or Photo category.

 [Color Matching:]: Specify the type of the color profile 

appropriate for the type of the original.

 [Pure Black:]: Specify whether to print the gray areas of the 

original using only the black toner.

 [Screen:]: Specify the screen processing for the print image.

 [RGB Color:]: Specify the color space of the input RGB used 

for printing.

 [Destination Profile:]: Specify the output profile used for 

printing. You can specify only the new ICC profiles registered 

in this machine.

Note

 -  The settings of [Color Matching:], [Pure Black:], [RGB Color:], 

and [Destination Profile:] are common to all the elements.

 -  The setting of [Screen:] is common to the Photo and Figure/

Table/Graph elements. 
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Settings Description

[Simulation] Configure the simulation settings.

 [Simulation Profile]: Select the simulation profile of the input 

CMYK used for printing.

 [CMYK Gray Treatment:]: Specify the printing method of plate 

K in the CMYK input data for simulation.

 [Match Paper Color:]: Select whether or not to suit the 

background of paper for printing when carrying out a simulation.

3 Click [OK]. 

 Color processing is performed according to the selected ICC profiles.

 

Adding ICC profiles to the printer driver

  To use this function, contact your service representative.

   To register ICC profiles in this machine, use Download Manager. For details on how to register 

ICC profiles in this machine, refer to the Help for Download Manager.

1 In [Quality], click [Quality Adjustment].
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2 Click [Manage Profile].

  If the Download Manager has been installed and if you click [Download Manager], the 

Download Manager starts.

3 Select a color profile type from the drop-down list.

4 Select the desired profile from the [Available Profile] list, then click [Add Sel].

 The profile name can be changed in [New/Edit].

  If the profile is not displayed in the list, click [New], and enter [File Name] and [Profile Name] 

of the profile registered in this machine.

5  Click [OK]. 

The profile is added to [Driver Profile List].
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4. Printing options

Making a Trial Printing ([Proof Print]) 

Proof Print

The Proof Print function is used when printing multiple copies. It allows the printer to output 

one copy and pause the printing operation before printing the remaining copies.

Because you can check the print result before starting to print the remaining copies from the 

Control Panel, this function is useful for preventing printing of a large number of misprints.

 Note

  - To use this function, contact your service representative.

How to print from the computer

1 In [Output Method:] in the [Output Method], select [Proof Print].

2  Specify the number of copies, then execute printing. 

Only one copy is printed. Continue to “Operations on this machine”.
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Operations on this machine

1 On the main screen of the copy mode, select [Print Function] by pressing the ▲/▼ key,  

 then press Select key.

2 Select [Proof Print] by pressing the ▲/▼ key, then press the Select key.

3 Select the job to print by pressing the ▲/▼ key, then press the Select key.

4 Select [Print] by pressing the ▲/▼ key, then press the Select key.

5 If necessary, change the number of copies, then press the Select key.

 The remaining copies are printed.
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Printing Highly Confidential Documents ([Secure Print])

Secure Print

Secure Print is a function that saves print data in the built-in flash memory of this machine with  

a password. Because the data is not printed straight away, this function prevents printed materials 

from going missing or being left unattended.

To print data from the built-in flash memory, you need to enter the password; this function is  

particularly suitable for safely printing highly confidential documents.

 Note

  - To use this function, contact your service representative.

How to print from the computer

1 In [Output Method:] in the [Output Method], select [Secure Print].

2 Enter the ID and password, then click [OK].

   When the [Save Settings] check box is selected, the settings are saved. When the [Do not 

show this window when setting] check box is selected, this dialog box is not displayed next 

time. If you always use the same ID and password, selecting this check box eliminates the 

need for entering them each time.
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3  Execute printing. 

The print data is saved in the built-in flash memory of this machine. Continue to “Operations 

on this machine”.

  You can issue a print instruction from the Control Panel before print data scanning on this 

machine is completed. However, printing is executed after print data scanning on this machine 

has been completed.

Operations on this machine

To print the saved data, you need to enter the password specified in the printer driver.

1  On the main screen of the copy mode, select [Print Function] by pressing the ▲/▼ key, then 

press the Select key.

2 Select [Secure Print] by pressing the ▲/▼ key, then press the Select key.

3 Enter the Secure Print ID specified when printing data from the computer.

4 Enter the password specified when printing data from the computer.

5 Select the job to print by pressing the ▲/▼ key, and then press Select key.

6 Select [Print] by pressing the ▲/▼ key, then press the Select key.

7  If necessary, change the number of copies, then press the Select key.

 Printing starts.
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Attaching authentication information

Printing when authentication is set

When printing a document in an environment where user authentication or account track is employed, 

you need to send the authentication information (user name and password) to this machine to execute 

printing. This requirement limits the users who can use this machine, preventing unauthorized use by a 

third party.

When this machine receives a print job from a user who is not permitted to print, or a print job that 

does not contain authentication information, this machine automatically discards the job.

 Note

  -  A print job that does not contain authentication information is a print job that is sent  

without correctly configuring the User Authentication/Account Track setting using the  

printer driver even though the User Authentication/Account Track setting is configured on  

this machine. 

If [Print] in [Output Method:] is selected while the [User Authentication]/[Account Track] 

check box is cleared on the [Output Method] window of the printer driver, the print job is 

considered as a print job without authentication information.

How to print from the computer

1  In the [Output Method], select the [User Authentication] check box (and the [Account Track] 

check box).
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2  When user authentication is enabled, select [Recipient User], enter the user name and password, 

then click [OK].

   If access to this machine by public users (unregistered users) is allowed, you can select 

[Public User] and print data without entering the user name and password.

  When the [Save Settings] check box is selected, the settings are saved. When the [Do not 

show this window when setting] check box is selected, this dialog box is not displayed next 

time. If you always use the same user name and password, selecting this check box eliminates 

the need for entering them each time.

3  When account track is enabled, select the [Account Track] check box, enter the account name 

and password, then click [OK].

4  Execute printing. 

Printing starts successfully when the authentication information is judged correct.
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5. Printer driver setting items

[Page Setup] window of the printer driver

How to display the [Page Setup] window

1  Open the original data using the application software. From the [File] menu, click [Page Setup] 

(or [Paper Setup]).

2 Check that the desired printer is selected in [Format for:].

 The [Page Attributes] window appears.

Available operations in [Page Attributes]

In [Page Attributes], you can configure basic paper settings.

Settings Description

[Paper Size:] Select the size of paper for printing.

To print on custom sized paper, use [Manage Custom Sizes]. 

For details, refer to P. 3-12.

[Orientation:] Specify the orientation of the original created in application 

software.

If the setting in the printer driver differs from the one specified in 

the application software, correct the setting.

[Scale:] Specify the zoom ratio to enlarge or reduce the original image. 

The setting range differs depending on the Mac OS X version.

 Note

  -  In Mac OS X 10.5 or later, you can also specify [Paper Size] and [Orientation] in the [Print] 

window.



Printing in the Mac OS Environment

3-30

[Print] window of the printer driver

How to display the [Print] window

1 Open data of the original using the application software. From the [File] menu, select [Print].

2 Check that the desired printer is selected in [Printer:].

Items common to each window

This section describes the settings and buttons common to the [Print] window.

Settings Description

[Copies:] When printing multiple sets of copies, specify the number of sets.

[Collated] Do not specify this function.

In [Output Method], select the [Collate] check box.

[Pages:] When printing a multi-page original, specify the range of pages 

to be printed.

[Paper Size:] Specify the size of the paper to be printed.

Note

 -  [12 x 18] in Paper Size is equivalent to 304.8 x 457.2 mm that is 

slightly larger than A3.

[Orientation:] Specify the printing orientation.

View Displays the sample page layout based on current settings for 

checking the print result image.

Note

 - In [Quality], you can change between the preview images.

 -  [Paper View]: Select this check box to change the preview to 

the print image.

 -  [Detailed Information]: Select this check box to change the 

preview to the image of the current image quality setting.
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Settings Description

[Version] Displays the version of the printer driver.

[Cancel] Discards (or cancels) the current changes and closes the setting 

window.

[Print] Applies the changes made to the settings and starts printing.

 Note

  -  [Copies:], [Pages:], [Paper Size:], and [Orientation:] are displayed in Mac OS X 10.5 or later.

  -  View and [Version] are displayed in [Output Method], [Layout / Finish], [Paper Tray],  

[Cover Mode], and [Quality].

  - In Mac OS X 10.7/10.8/10.9, [Collated] is not displayed.

  - In Mac OS X 10.3/10.4, [Copies:] and [Pages:] can be specified in [Copies & Pages].

Available operations in [Layout]

In [Layout], you can configure layout settings for printing.

Settings Description

[Pages per Sheet:] Select how many pages are to be printed on the same side of 

one sheet.

For example, when you select [9], every set of nine pages is reduced 

and printed on the same side of one sheet.

[Layout Direction:] Select the paging order when [Pages per Sheet:] is specified.

[Border:] Select whether or not to insert a border line between pages when 

[Pages per Sheet:] is specified. If you want to insert a border line 

between pages, select the border line type.

[Two-Sided] Do not specify this function.

In [Print Type:] of the [Layout / Finish], select this function.

[Reverse page 

orientation]

Select this check box to rotate a print image 180 degrees.

[Flip horizontally] Select this check box to reverse the left and right sides of a print 

image.

 Note

  - [Reverse page orientation] is displayed in Mac OS X 10.5 or later.

  - [Flip horizontally] is displayed in Mac OS X 10.6 or later.
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Available operations in [Scheduler]

In [Scheduler] you can specify the print starting timing or priority sequence.

Settings Description

[Print Document:] Specify the timing to start printing.

[Now]: Starts printing immediately.

[At]: Starts printing at the specified time.

 [On Hold]: Holds print jobs in the computer. Printing can be 

started from the job screen of the printer.

[Priority:] Specify the priority level of each print job.

 Note

  - This function is available only for Mac OS X 10.3/10.4/10.5/10.6.

Available operations in [Paper Handling]

In [Paper Handling], you can specify pages to be printed or their order.

Settings Description

[Collate pages] Do not specify this function.

In [Collate] of [Output Method], select this function.

[Pages To 

Print:]/[Print:]

Specify the pages to be printed from All, Odd, and Even.

[Page Order:] Specify the order of pages to be printed.

 [Automatic]: Automatically judges the order of pages to be 

printed.

[Normal]: Prints pages in sequence from the first.

[Reverse]: Prints pages in sequence from the last.

[Reverse page order] Select this check box when printing from the last page in order.

[Destination Paper 

Size:]

Specify the size of the paper to be printed.

 [Scale to fit paper size]: Prints data on sheets of the specified 

size.

[Scale down only]: Prints data only on sheets to be reduced.
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 Note

  - [Collate pages] is displayed only in Mac OS X 10.7/10.8/10.9.

  - [Page Order:] is displayed in Mac OS X 10.4 or later.

  - [Reverse page order] is displayed only in Mac OS X 10.3.

  - [Destination Paper Size:] is displayed in Mac OS X 10.4 or later.

Available operations in [ColorSync]

In [ColorSync], you can specify the color conversion method or Quartz filter.

Settings Description

[Color Conversion:] Select the color conversion method.

[Standard]: Performs color conversion using the computer.

[In Printer]: Performs color conversion using the printer.

[Quartz Filter:] Specify the Quartz filter to be applied.

 Note

  - This function is available only for Mac OS X 10.3/10.4.

Available operations in [Color Matching]

In [Color Matching], you can specify the color conversion method or a color profile.

Settings Description

[ColorSync] / 

[In Printer]

Select the color conversion method.

[ColorSync]: Performs color conversion using the computer.

[In Printer]: Performs color conversion using the printer.

[Profile:] Specify the color profile to be used for color conversion.

 Note

  - This function is available only for Mac OS X 10.5 or later.
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Available operations in [Cover Page]

In [Cover Page], you can configure settings to print a cover page.

Settings Description

[Print Cover Page:] Select whether or not to print a cover page at the head or end of 

a document.

[Cover Page Type:] Select the type of a message to be printed on a cover page.

[Billing Info:] Enter billing information when printing it on a cover page.

Available operations in [Error Handling]

In [Error Handling], you can specify processing when an error has occurred during PS printing.

Settings Description

[PostScript Errors] Select whether or not to output a report when an error has oc-

curred during PS printing.

[Tray Switching] This function is not used in this printer driver.

 Note

  - This function is available only for Mac OS X 10.3/10.4.

Available operations in [Output Method]

In [Output Method], you can configure settings for printing processes.

Settings Description

[Sort] When printing multiple sets of copies, select this check box to 

output sets of copies one by one.

When this check box is cleared, the first page of the original is 

printed on as many sheets as the number specified in [Copies], 

then each of the subsequent pages is printed in this manner.

[Output Method:] Select the method to use to print the original from this machine.

[Print] Select this option to print normally.

[Secure Print] Select this option to print highly confidential documents. 

Printing is allowed when the ID and password are entered on this 

machine.

For details, refer to P. 3-25.
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Settings Description

[Proof Print] Select this option to print a large number of copies. This machine 

prints only one copy and waits for the user’s command before 

printing the remaining copies.

For details, refer to P. 3-23.

[User Authentication] Select this check box when user authentication is employed. In 

the window that appears, enter the user name and password.

For details, refer to P. 3-27.

[Account Track] Select this check box when account track is employed. In the 

window that appears, enter the account name and password.

For details, refer to P. 3-27.

[Detail Settings] Click this button to display the window for configuring the detail 

settings.

Clicking [Detail Settings] displays the [Output Method] functions for which detail settings can be 

specified. Selecting a function and clicking [Settings] displays the window for specifying the detail 

settings for the selected function.

Settings Description

[Secure Print] Enter the ID and password for Secure Print. For details, refer to 

P. 3-25.

[User Authentication] When user authentication is employed, enter the user name and 

password. For details, refer to P. 3-27.

[Account Track] When account track is employed, enter the account name and 

password. For details, refer to P. 3-27.

[Administrator Settings] Change the setting for whether to display the detailed setting 

dialog box for each function at printing.

Note

 -  If the sandbox-compatible application is used in Mac OS X 10.9, 

you cannot use the settings that is displayed in the dialog box.

 Note

  -  If the sandbox-compatible application is used in Mac OS X 10.9, you cannot use [Save 

Settings] that is displayed in each setting dialog box.
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Available Operations in [Layout / Finish]

In [Layout / Finish], you can configure layout settings for printing.

Settings Description

[Print Type:] Select the print sides of paper.

 [1-Sided]: The original is printed on one side of a sheet of 

paper.

 [2-Sided] (D202/D201): The original is printed on both sides 

of a sheet of paper.

[Binding Position:] Select the paper binding position.

[Rotate 180] Select this check box to rotate the original 180 degrees and print it.

Available Operations in [Paper Tray]

In [Paper Tray], you can specify the paper trays and type of paper used for printing.

Settings Description

[Output Tray:] Select the paper tray for the printing paper.

When you select [Auto], the tray containing the paper selected in 

[Paper Size:] and/or [Paper Type:] is automatically used.

[Paper Type:] Select the type of sheets to be printed.
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Available Operations in [Cover Mode]

In [Cover Mode], you can insert covers into the printouts.

Settings Description

[Front Cover:] Select this check box to insert and print on a front cover. 

In addition, select the paper tray for the front cover and whether 

to print on the inserted front cover.

[Blank]: Nothing is printed on the inserted front cover.

 [Print]: The first page of the original is printed on the inserted 

front cover. You can set this option when you have selected 

anything other than [Auto] in [Output Tray:] in [Paper Tray].

[Back Cover:] Select this check box to insert and print on a back cover. 

In addition, select the paper tray for the back cover and whether 

to print on the inserted back cover.

 [Blank]: Nothing is printed on the inserted back cover.

 [Print]: The last page of the original is printed on the inserted 

back cover. You can set this option when you have selected 

anything other than [Auto] in [Output Tray:] in [Paper Tray].

Available operations in [Quality]

In [Quality], you can configure settings for the image quality of the original. You can specify colors 

and image processing.

Settings Description

[Select Color:] Select colors for printing.

 [Auto Color]: The color mode is automatically selected according to 

the original color.

 [Gray Scale]: The original is printed in black and white regardless of 

whether or not the original is in color or in black and white.

[Toner Save] Select this check box to save the amount of toner consumed. 

The printing density is reduced.

[Color Settings:] Select the optimum color setting mode for the original.

 [Document]: The color setting suitable for originals containing 

multiple elements, such as text, graphs, figures, and photos, 

is applied.

 [Photo]: The color setting that prioritizes the image quality is 

applied.
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Settings Description

[Quality Adjustment] The image quality is fine tuned according to the original.

For each element of the document, specify in detail the type of 

the color profile used for printing and other profiles to be applied.

You can also manage ICC profiles. For details, refer to P. 3-20.

 Note

  -  If the sandbox-compatible application is used in Mac OS X 10.9, you cannot use [Save 

Settings] that is displayed in each setting dialog box.

Available operations in [Supply Levels]

In [Supply Levels], you can check the status of consumables.

 Note

  -  This function is displayed when a Bonjour connection, IPP connection, or LPD connection 

is established in Mac OS X 10.4 or later.

  -  This function may not be displayed depending on your application software.

Available operations in [Summary]

In [Summary], you can check the current print settings

 Note

  - This function is displayed only in Mac OS X 10.3/10.4/10.5/10.6.
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6. Uninstalling the printer driver

When you have to remove the printer driver, for example, when re-installation of the printer driver  

is necessary, uninstall the driver using the following procedure.

1 Open [System Preferences] in the Apple menu, then click the [Print & Fax icon].

  In Mac OS X 10.7/10.8, click the [Print & Scan] icon. In Mac OS X 10.9, click the [Printers  

& Scanners] icon.

  In Mac OS X 10.3, select [Macintosh HD] (system hard disk) - [Applications] - [Utilities], 

then double-click [Printer Setup Utility] or [Print Center] to open it.

2  Select the printer you want to delete, then click [-] (or [Delete]). 

The selected printer is deleted.

3 Close the screen.

4  Select [Macintosh HD] (hard disk of the system) in which you installed the printer driver, then 

select [Library] - [Printers] - [PPDs] - [Contents] - [Resources] ([Resources] in Mac OS X 

10.5 or later, each language folder in [Resources] in Mac OS X 10.3/10.4). Then, drag the gz file 

of this machine to [Trash].

5 Delete unnecessary files from [Library] - [Printers].

   Open [Library] - [Printers] - [Sindoh], then drag the folder of this machine to [Trash].

6  In Mac OS X 10.3/10.4/10.5, open [Library] - [Recipients], then drag the pkg file of this machine 

to [Trash].

7  Restart the computer. 

Uninstallation of the printer driver is then completed.
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1. Directly printing from the computer (Direct Print)

Direct Print

Direct Print is a function that directly sends files on your computer to this machine to print them 

without using the printer driver. You can print a file stored on your computer by specifying it using 

Web Connection.

This function is available for file types PDF, JPEG, TIFF, XPS, PS, PCL, Text, OOXML (.docx/.xlsx/.

pptx), and PPML (.ppml/.vdx/.zip).

 Note

  - However, the encrypted PDF file cannot be printed.

  - A text file supports only 1-byte characters.

  - To use the OOXML file print function, contact your service representative.

  -  Application software programs that offer the same function as Direct Print of Web Connection 

through simpler operations include Direct Print. Features such as printing through drag-and- 

drop to the desktop icon, printing using the [Send To] menu in Windows, and automatic printing 

using a hot folder (print monitoring folder) are available. You can also register multiple job 

settings in which print settings are configured. To download Direct Print, select [PageScope 

Utilities] in the Driver CD menu, then display the page to download utility software. For details, 

refer to the Direct Print manual.

How to use Direct Print

Connect to Web Connection using a Web browser, then specify the file you want to print.

1 Access to the Web Connection using the Web browser.

  Enter the IP address of this machine in the URL field of the Web browser, then press the 

Enter key on the keyboard. 

http://<IP address of this machine>/

2 Log in with the account of a public user or registered user.

3 Click [Direct Print].
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4 Click [Browse] to select a file to print, then click [OK].

   Change the print settings as necessary.

 The file is sent and printed.
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Related setting

 To print a text file, you need to set [DEF. EMULATION] to [AUTO] (default: [AUTO]). For details,  

refer to [User’s Guide Description of Utility Keys].

 You can configure the method to set a combination when directly printing  

To configure settings: Utility key - [User Settings] - [Printer Settings] - [Layout-Combination]

 You can configure print settings to directly print an OOXML (.docx/.xlsx/.pptx) file. 

To configure settings: Utility key - [User Settings] - [Printer Settings] - [OOXML Print Set]

 You can specify the method for determining the paper size when directly printing a TIFF, JPEG,  

or PDF file. 

To configure settings: Utility key - [User Settings] - [Printer Settings] - [PAPER MENU] - [TIFF 

Paper Setting] (default: [Auto Paper Select])

 You can specify whether to slightly reduce the full page size when directly printing a PDF, OOXML 

(.docx/.xlsx/.pptx), or PPML (.ppml/.vdx/.zip) file. 

To configure settings: Utility key - [User Settings] - [Printer Settings] - [PAPER MENU] - [Minimal 

Print] (default: [OFF])

 You can specify whether to verify the digital signature when directly printing an XPS or OOXML 

(.docx/.xlsx/.pptx) file. 

To configure settings: Utility key - [User Settings] - [Printer Settings] - [XPS] - [DIGITAL SGN.] 

(default: [OFF])

 You can specify whether to print error information when an error occurs while printing an XPS or 

OO- XML (docx, xlsx, or pptx) file. 

To configure settings: Utility key - [Admin Settings] - [Printer Settings] - [XPS ERROR PAGE] 

(default: [Print])
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2. Printing directly from a USB memory device

Printing from a USB memory device

By connecting a USB memory device to this machine and specifying a file stored in the USB memory 

device, you can print the file.

This function is available for file types PDF, Compact PDF, JPEG, TIFF, XPS, Compact XPS, Open 

XPS, OO- XML (.docx/.xlsx/.pptx), and PPML (.ppml/.vdx/.zip).

 Note

  - However, the encrypted PDF file cannot be printed.

  - To use the OOXML file print function, contact your service representative.

Related setting (for the administrator)

You can specify whether to enable or disable printing data from USB memory.

To configure settings: Utility key - [Admin Settings] - [System Setting] - [ExtMemFuncSettings] - 

[Print Document] (default: [ON])

Supported USB memory devices

USB memory devices that have the following specifications can be connected to this machine.

Item Specifications

Supported media USB memory device (USB 2.0/1.1 supported)

File system FAT32

 Note

  - Note the following points when connecting a USB memory device to this machine.

  - Use the USB connector on the side that is near the Control Panel.

  -  Do not disconnect the USB memory device while saving a file to the USB memory or printing a 

file in the USB memory.

  -  Use only a USB memory device on this machine. Do not use other USB devices (such as a 

hard disk unit or USB switching hub).

  -  Do not connect or disconnect the USB memory device when the hourglass is displayed in 

the Message Window while this machine is active.

  -  Do not disconnect the USB memory device directly after connecting it.



Printing without Using the Printer Driver

4-6

Printing procedure

1 Connect a USB memory device to the USB port of this machine.

2  On the main screen of the copy mode, select [USB to Print] by pressing the ▲/▼ key, then 

press the Select key.

3  To print a file other than PDF or XPS format, select [File Type] by pressing the ▲/▼ key, then 

press the Select key. Select [ALL] by pressing the ▲/▼ key, then press the Select key.

   The setting selected in [File Type] is also applied to the next operation and after. When selecting a 

file to print, if you want to display only PDF and XPS format files, change the setting of [File Type] to 

[PDF, XPS].

4 Select [File List] by pressing the ▲/▼ key, then press the Select key.

5 Select the file to print by pressing the ▲/▼ key, then press the Select key.

  Select [Up] to move upward.

    Select a folder to open the folder and move to a lower level.

6 If necessary, change print settings, then select Start.

Settings Description

[Paper] Select the paper tray for the printing paper. The paper size can be 

specified when the selected file type is TIFF or JPEG.

[DUPLEX] (D202/D201) Select whether or not to print data on one side or both sides of 

sheets of paper. To print data on both sides, select the binding 

position.

[COPIES] Set the number of copies to print.

[Collate] When printing data by multiple copies, select whether or not to 

feed out copies separately one by one like “12345”, “12345”, 

and “12345”.
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Related setting

 You can configure the method to set a combination when directly printing To configure settings: 

Utility key - [User Settings] - [Printer Settings] - [Layout-Combination]

 You can configure print settings to directly print an OOXML (.docx/.xlsx/.pptx) file. 

To configure settings: Utility key - [User Settings] - [Printer Settings] - [OOXML Print Set]

 You can specify the method for determining the paper size when directly printing a TIFF, JPEG, 

or PDF file. 

To configure settings: Utility key - [User Settings] - [Printer Settings] - [PAPER MENU] - 

[TIFF Paper Setting] (default: [Auto Paper Select])

 You can specify whether to slightly reduce the full page size when directly printing a PDF,  

OOXML (.docx/.xlsx/.pptx), or PPML (.ppml/.vdx/.zip) file. 

To configure settings: Utility key - [User Settings] - [Printer Settings] - [PAPER MENU] - 

[Minimal Print] (default: [OFF])

 You can specify whether to verify the digital signature when directly printing an XPS or OOXML 

(.docx/.xlsx/.pptx) file. 

To configure settings: Utility key - [User Settings] - [Printer Settings] - [XPS] - [DIGITAL 

SGN.] (default: [OFF])

 You can specify whether to print error information when an error occurs while printing an XPS or 

OOXML (docx, xlsx, or pptx) file. 

To configure settings: Utility key - [Admin Settings] - [Printer Settings] - [XPS ERROR PAGE] 

(default: [Print])
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